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1 Introduction

1.1 About this manual

The scope of this ‘Getting Started Guide’ is to help you install and run
GFI MailEssentials on your network with minimum configuration effort.
It describes:

1. The various environments and email infrastructures supported by
this product
2. Guides you through the respective installation procedure

3. Walks you through the key steps needed to get the product running
on default settings.

Manual structure

The sections in this manual are ‘self contained’ and are designed to
guide you through the sequence of steps needed to:

1. Identify product prerequisites applicable to your network
2. Prepare your environment for product installation

3. Install/upgrade GFI MailEssentials

4. Configure, test and run the product.

The sections in this manual are structured as follows:

Chapter 1 Introduces this manual.

Chapter 2 Provides a high-level overview of how GFl
MailEssentials works.

Chapter 3 Gives detailed information on how to install GFI
MailEssentials on Windows Server environments
running Microsoft Exchange 2000 or 2003.

Chapter 4 Provides detailed information on how to install GFlI
MailEssentials on Windows Server environments
running Exchange 2007.

Chapter 5 Provides detailed instructions on how to install GFl
MailEssentials for Lotus Domino email servers.

Chapter 6 Gives detailed information regarding the installation of
GFI MailEssentials for other SMTP Servers.

Chapter 7 Provides guidelines on how to troubleshoot common
issues.

Glossary Includes a collection of specific technical terms used in
this manual.

Follow the instructions for your type of network using the appropriate
section in this manual. Where applicable each section contains
information related to installing GFI MailEssentials on the same server
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as your mail server, on a mail gateway or relay/perimeter server or in
a clustered environment.

Administration and configuration manual

Detailed administration and configuration guidelines are provided in a
separate manual called GFI MailEssentials administration and
configuration manual which is installed with the product or
separately downloadable from the GFI web site:

http://www.dfi.com/mes/mes14acmanual.pdf

This Administration and Configuration manual complements this
Getting Started Guide by providing more detailed information on how
to use and customize the features provided in GFI MailEssentials (e.g.
tweaking of anti spam filters).

1.2 Terms used in this manual

The following terms are used in this manual:
o “NOTE:”

o0 This provides additional information and references
essential to GFI MailEssentials’ operation.

e “IMPORTANT:”

0 This provides important information such as warnings and
cautions that advise of potential issues commonly
encountered.

For any technical terms and their definitions as used in this manual
refer to the Glossary chapter.

1.3 Licensing

Information on licensing is available on:
http://www.gfi.com/products/dgfi-mailessentials/pricing/licensing
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2 How does GFI MailEssentials work?

2.1 Inbound mail filtering

Inbound mail filtering is the process through which incoming email are
filtered before delivery to users.

1. On establishing a connection, the
incoming email’s recipient email
address is checked and if it is not found
the connection is immediately

terminated. This is done through the

directory-harvesting  filter. If  the ®: . % Recpient

recipient email address is found, email

goes to next stage. o { }

2. Next the email is checked to see if it dropped — —
is addressed to a list server. If this is Dfsfli_gfd Yes =
the case the email is forwarded to the Sorvar |
list server, else it goes to the next @ List Server
stage.

3. The incoming email is filtered using Sp:;:mFR':::rng

all the spam filters. Any email that fails WB%

a spam filter check is sent to the anti : SPT
spam email actions. If an email goes ®- <:| DimweHumm

1 i [ Custom Blacl&_|
through all the filters and is not il JaiomFaRdh
. e . Arti-spam TTREL
identified as spam, it then goes to the email DNSRBL_

t st actions Header Checking
next s age. Keyword Checking
4. If configured, email is next archived {}

to the reporting database. The mail

goes to the next stage. Archive :'>@
5. If configured, auto-replies are next

sent to the sender. Email goes to next {} e
stage.

6. If configured, email monitoring is next s :>E|
executed and the appropriate actions —
taken. Email goes to the next stage. U ‘message
7. The new senders filter is now

executed. Email goes to the next stage. Wil

M onitoring
8. Email is sent to the user’s mailbox.

~

New
Senders

;‘{13

User Mailbox
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Inbound email domains

A very important concept within GFI MailEssentials is that of inbound
email domains. During its configuration, GFI MailEssentials will
automatically detect the domains on which you receive emails. This
enables it to distinguish between inbound and outbound emails and
therefore protect your network against spam. Inbound email domains
are also configurable after installation through the GFI MailEssentials
Configuration console. For more information refer to the GFlI
MailEssentials Administration and Configuration manual.

2.2 Outbound mail filtering

Outbound mail filtering is the process through which email sent by
users within a company is processed before it is sent out.

/

1. User creates and sends email.

s
L
&

2. Remote commands check executes
any remote commands in email if any
are found. If none are found, email
goes to the next stage.

User Mailbox

-

Remote
command
check

3. Email is next checked to see if it
should be archived. If archiving is

A

enabled, email is saved in the reporting _
database. In all cases email goes to the Archive :>9

next stage.

g

4. If configured, the applicable

disclaimer is next added to the email. s
Once this is done, the email goes to the
next stage.

g

5. Email is checked for any mail Wail
monitoring which may apply and action Monitoring
is taken according to any rules
configured. Email goes to the next
stage.

-

6. If enabled, the auto-whitelist check
adds the email recipient email address
to the whitelist. This automatically
enables replies from such recipients to
go to the sender without verification.
After this check, emails are sent to the
recipients.

Internet

The outbound email sequence of events is followed by all outbound
emails, except for outbound email processes initiated by the list
server. This feature enables the creation and routing of distribution
lists (newsletters and discussion lists) from GFI MailEssentials. In this
case, emails are scanned for spam and automatically sent to
recipients.

Reporing
Database
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3 Installation for Microsoft Exchange
2000 & 2003

3.1 Introduction

GFl MailEssentials installation depends on how your network is
configured for Exchange 2000/2003. You can install this product on:

e The dedicated mail server : This setup is typically used to filter
email spam on the mail server (running Microsoft Exchange) that
is configured to receive emails directly from the internet.

e The SBS 2000/2003 server: This setup is used to filter email
spam on the SBS 2000/2003 server, which uses Microsoft
Exchange to receive emails directly from the internet.

e The mail relay server: This setup is commonly used to filter spam
in distributed email infrastructures., especially those running a
DMZ. In this environment a dedicated machine (also known as a
gateway/perimeter server. Us set to relay emails to another mail
server (running Microsoft Exchange). GFI MailEssentials is
installed on the gateway/perimeter server so that email spam is
filtered before reaching the mail server. This setup reduces
network traffic, email storage and processing requirements on your
mail server.

e Microsoft Exchange Server & IIS Clusters: This type of
installation is commonly used to filter spam within environments
where clusters are used as disaster prevention and recovery.

3.2 System requirements
3.2.1 Software

Supported operating systems

Microsoft Windows Server 2008 x64

Microsoft Windows Server 2003 Standard/Enterprise (x86 or x64)
Microsoft Windows 2000 Server/Advanced Server (SP1 or higher)
Microsoft Small Business Server 2000 (SP2) / 2003 (SP1)

Mail Servers

e Microsoft Exchange Server 2000 (SP1) / 2003 (SP2)

Other components

e Microsoft .NET Framework 2.0
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e Microsoft XML core services: This is required by the GFI
MailEssentials reporter to enable anti spam report generation. For
UK/US English OS this is installed automatically by GFI
MailEssentials. For other languages, this can be downloaded from:

http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e Microsoft Virtual Server cluster group resource with a physical disc
cluster. This is required ONLY for environments running Microsoft
Exchange 2000/2003 clusters. For more information refer to:

http://technet.microsoft.com/en-
us/library/bb124318(EXCHG.65).aspx

e (OPTIONAL) Microsoft Message Queuing Services: This is
required ONLY if list servers are used. MSMQ is used by GFI
MailEssentials to ensure the reliable running of distributions lists
on list servers. For more information on list servers refer to ‘List
servers’ section in the Administration and Configuration manual.

3.2.2 System requirements: Hardware

Processor

e Minimum: Intel Pentium or compatible 1 GHz 32-bit processor

e Recommended: x64 architecture-based server with Intel 64
architecture or AMD64 platform.

Memory

¢ Minimum: 1GB

¢ Recommended: 2GB RAM
Physical Storage

¢ Minimum: 500MB for installation, 2GB for execution.
e Recommended: 500MB for installation, 4GB for execution

3.3 Important settings

3.3.1 Antivirus and backup software

Antivirus and backup software may cause GFI MailEssentials to
malfunction. This occurs when such software denies access to certain
files required by GFI MailEssentials.

Disable third party antivirus and backup software from scanning the
following folders:
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x86 installations (32-bit) X64 installations (64-bit)

<..\Program Files

<.\Program Files\GFI\MailEssentials> (x86)\GFI\MailEssentials>

<..\Program Files (x86)\Common

<..\Program Files\Common Files\GFI> Files\GEI>

<.\Inetpub\mailroot> If installed on a gateway machine.

<..\Program Files\Exchsrvr\Mailroot> If installed on the same machine as
Microsoft Exchange 2000/2003.

3.3.2 Firewall port settings

Configure your firewall to allow the following port connections. These
ports are used by GFIl MailEssentials to connect to GFI servers:

e DNS (Port 53) - Used by anti spam filters (DNS blacklist, Sender
Policy Framework, Header Checking) to identify the domain from
where received emails originated.

e FTP (Ports 20 and 21) — Used by GFI MailEssentials to connect
to ‘'ftp.dfisoftware.com' and retrieve latest product version
information.

e HTTP (Port 80) — Used by GFI MailEssentials to download
product patch and anti spam filter updates (i.e. SpamRazer, Anti-
Phishing, and Bayesian anti spam filters) from the following
locations:

o 'http://update.gfi.com’

o ‘http://update.dfisoftware.com’

'http://support.gfi.com’

o ‘'http://db11.spamcatcher.net' (GFI MailEssentials 14 or earlier)
o0 'hitp://sn92.mailshell.net' (GFI MailEssentials 14 SR1 or later)

e Remoting (Ports 8021) - Used in the latest builds of GFI
MailEssentials for inter-process communication. No firewall
configuration is required to allow connections to or from the
remoting ports since all the GFI MailEssentials processes run on
the same server.

e NOTE: Ensure that no other applications (except GFlI
MailEssentials) are listening on port 8021.

e (OPTIONAL) LDAP (Port 389) — Used by GFI MailEssentials to
get email addresses from SMTP server. Only required if the server
running GFI MailEssentials does not have access/cannot get list of
users from Active Directory e.g. in a DMZ environment or other
environment which does not use Active Directory.

o

3.4 Installing on Microsoft Exchange Server 2000/2003

3.4.1 Upgrade from earlier version

If you are currently using a previous version of GFI MailEssentials
(versions 9, 10, 11 and 12), you can upgrade your current installation
while at the same time retain all your existing configuration settings.
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Important notes

¢ Upgrades cannot be undone i.e. you cannot downgrade to an
earlier version once you have installed the latest version.

¢ On upgrading an existing installation, licensing reverts to trial
version and a new fully purchased license key for the GFl
MailEssentials 14 is required. For more information on new license
keys, refer to: http://customers.gfi.com

e You cannot change the installation path during GFI MailEssentials
upgrades.

e When upgrading from GFI MailEssentials 9, the current Bayesian
weights file will be upgraded to the new format used in GFI
MailEssentials 10 or later. The new format is more compact and
uses less memory. NO DATA WILL BE LOST.

Upgrade procedure

1. Launch GFI MailEssentials installation on the server where your
earlier version of GF|l MailEssentials is installed.

GFI MailEssentials <]

€ | GFIMalEssentials version 12.0.2007.1203 is already installed. ‘fou must uninstall the existing version befors installing GFI
__-/ MailEssentials version 12.0,2008.0524,

IMPORTANT: The new build requires the Microsaft \MET Framework 2.0 installed an this machine,

Do wou wank to uninstall the existing version of GFI MailEssentials?

Screenshot 1 - Confirm the upgrade

2. Click Yes to start the upgrade process and follow on-screen
instructions. For assistance refer to New installations section below.

3.4.2 New installations

Pre-install actions

No pre-install actions or configurations are required.

Important notes

1. At the end of the installation process, GFI MailEssentials will restart
Microsoft Exchange Server services. This is required to allow GFI
MailEssentials components to be registered and started. Failing to
restart the SMTP service will negatively affect anti spam filtering and
email flow.

2. Before starting installation, close any running Windows applications.

Installation procedure

1. Logon your Microsoft Exchange Server machine using administrator
credentials.

2. Double click mailessentials14.exe (32-bit install) or
mailessentials14_x64.exe (64-bit install) accordingly.

3. Select install language and click Next.
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4. Select whether to check for newer versions/builds of GFlI
MailEssentials and click Next.

5. Read licensing agreement. To proceed with the installation select |
accept the license agreement and click Next.

6. Click Next to install in default location or click Browse to change
path.

7. Specify user details and enter license key. Click Next to continue.

8. Specify the email address where notifications (e.g. failed anti spam
filters, spam digests) are sent.

{5 GFI MailEssentials Setup & 3 |

Active Directory

Access to Active Directony users

[Dloes thiz zerver have accezs to all the email uzers in Active Directony?

o Tes, all email uzers are available on Active Directory, rules will be bazed on
Active Directony users.

Ma, | do not have Active Diectary ar my network, dogs not have access o
Active Directory [DME], miles will be based on SMTP email addrezzes.

GFI M ailE zzential=®

Cancel |

Screenshot 2 - Selecting SMTP mode or Active Directory mode

9. Specify whether GFI MailEssentials will get the list of email users
(required for user-based configuration/rules e.g. disclaimers) from
Active Directory or SMTP server. Click Next to continue.
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]‘E GFl MailE szentials Setup [ [

Microzoft Meszage Queuing Service

The GFl MailE zzentials Lizt Server requires the Microzoft Meszage Queuing Service
[MSkE]. The Meszaging Queuing Service iz & scalable system service developed by
ticrozoft to enable high wolume event proceszing. Thiz service i included with eveny
Windows 2000, %P and 2003 verzionz, although not abways inztalled by default

The GFI MailE zzentialz installation can install MSMO for you, To complete thiz process,
wou will reguire the windows 2000, =P ar 2003 CD .

We recommend to inztall the MSMO at this point howeser pou can also install it at a later
stage. Fleaze note that you cannot uze the List Server without kS kGL

Do pou want toingtall the MSMO eervice now?

GFI MailE zzentials®

¢ Back Mewt = | Cancel

Screenshot 3 - Installing Microsoft Message Queuing Service

10. If Microsoft Message Queuing Services (MSMQ) is not installed
then the dialog in the above screenshot will open. To be able to use
list servers (i.e. distributions lists), select Yes to install MSMQ.

]'E GFI MaillEzsentials for Exchange/SMTP Setup M= E3

Confirm inbound email domains

Click Mext to begin inztallation.

The following inbound email domains were found:

gfi.co.uk
qgfi.cam
gfimalta.com
lozalhost

& GF| MailEzzentialz can only proceszs email: addrezzed to the domaing
listed abowve. Therefare, i SPAM email iz zent to a domain not listed
above it will not be blocked.

To further configure the above domainz, open the GFl Mailk szentialz
configuration, right click on the General node and select Properties

GFI b ailE zzential=®

< Back Mext » | Cancel

Screenshot 4 - Configure your inbound email domain

11. Setup will now display the list of inbound email domains detected.
Verify that all inbound email domains to be protected against spam
are listed. Take note of any changes required for post-installation and
click Next.
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NOTE: You can modify the list of inbound email domains ONLY post-
installation. For more information refer to the Confirm domains to
defend against spam section starting on page 15 in this manual.

12. Click Finish to finalize your installation. On completion, setup will:
e Ask you to restart the SMTP service.

IMPORTANT: Failing to restart the SMTP service will
negatively affect anti spam filtering and email flow.

e Check whether Microsoft XML engine is installed. This is
automatically installed if not found on UK/US English OS. For
other OS languages, this has to be manually downloaded and
installed. Microsoft XML engine can be downloaded from:
http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e Prompt you to launch the Quick Start Guide. This is a set of
instructions that will guide you through the configuration settings
required post-install/for first use (Recommended).

13. At this stage, GFI MailEssentials is installed. You must now
configure GFI MailEssentials for first use. For instructions refer to the
next section titled Post-install actions.

3.4.3 Post-install actions

To ensure that your GFI MailEssentials anti spam system is effectively
up and running you must perform the following post-install actions:

Step 1: Launch GFI MailEssentials Configuration console

Click on Start » All Programs » GFl MailEssentials » GFI
MailEssentials Configuration.

Step 2: Verify current DNS Server settings

1. Right click Anti spam node and select Properties.

2. Click on the DNS Server tab. Verify the DNS server details
automatically detected during install.

3. To specify a different DNS Server, select Use the following DNS
server and specify details.

4. Click Test to check your newly added DNS server settings.
5. Click OK to finalize your configuration.

Step 3: Confirm domains to defend against spam

NOTE: ONLY the inbound email domains configured in GFI
MailEssentials will be protected against spam.

1. Right click General node and select Properties.

2. Click on the Inbound Email Domains and ensure that all required
inbound domains are listed in the Inbound Domains field.

3. To specify additional domains, click Add... and enter inbound email
domain details.

4. Click OK button to finalize your configuration.
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Step 4: Enable Directory Harvesting

This filter uses Active directory or LDAP lookups to verify whether
inbound emails are addressed to legitimate ‘internal’ email accounts.
To enabile this filter:

1. Right click Anti spam node and select Directory Harvesting »
Properties.

2. Select Enable directory harvesting protection.
3. Select the lookups method to be used:

e Use native Active Directory lookups option — Select this option
if during installation you selected to get the list of email users from
Active Directory (see Installation Procedure section above — step
9).

e Use LDAP lookups — Select this option if during installation you
selected to get the list of email users from SMTP server using
LDAP (see Installation Procedure section above — step 9). In
addition:

0 Unselect the Anonymous bind option if your LDAP server
requires authentication

Enter the authentication details using Domain\User format.
0 Click Test button to test your LDAP configuration settings.

Step 5: Configure whitelists

This filter allows you to specify lists of ‘friendly’ email domains, email
addresses or |IP addresses.

WARNING: USE THIS FEATURE WITH CAUTION. Entries in this list
will not be scanned for spam and will bypass all anti spam filtering.

1. Right click Anti spam node and select Whitelist » Properties.
2. Click on the Whitelist tab.

3. Click Add... and specify domains/email addresses or IP addresses
to whitelist.

4. Click OK to finalize your configuration.

Step 6: Test your anti spam system

GFI MailEssentials is now ready to start managing spam. To verify
that anti spam is working properly:

1. Navigate to Start » All Programs » GFIl MailEssentials » GFI
MailEssentials Dashboard.

2. Using an external email account (for example webmail, hotmail or
Gmail), create a new email and key in “100% free” as the subject.

3. Send the email to one of your internal email accounts. GFI
MailEssentials will tag this email as spam by adding the tag [SPAM] to
the email ‘subject’ field.

4. Allow some time for email delivery and confirm that email spam
tagging is working by:
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[ GFI MailEssentials Dashboard Hi=l B3
File  Options Help

tatistics I PZE Logging I

— Statuz of key services
E@'I GFI b ailE zzential: M anaged Attendant Service iz Runhing I@I GFI List Server iz Bunning

L@I GFl MailE ssentials Legacy Attendant Service is Running 'Q' GFl MailE szentials POP2Eschange Service is Running
I@ GFl MailE szential: Enterprize Transfer Agent iz Running r@. 115 Adrmir Service iz Running

MTA Logging
Proceszed Time | Filker Lewvel | Sender | Recipients | Subject il
= 2/26/2003 3:00:24 PM FullEmal  "John Doe" <johndoe@ hotmail.coms johhdoe@domain.com 100%% Free

=l
J | o

Screenshot 5 - Testing your anti spam system

o Checking the GFI MailEssentials Dashboard. Use the Status tab
to view the status of key GFI MailEssentials services and email
processing activity. Receipt and processing status of this email is
logged in the MTA logging window.

Inbox - Microsoft Outlook
! Fle Edt WView Go Tool Actions Help Type

E_a_'mew =& 3 * | ,_;ﬁ Reply ;ﬂREpbeoAll __'3 Forward | g'_ﬁSend!Regewe ~ | ‘i.';;Fmd & | 3

Favorite Folders Y [ @ From Subject |Received Size kg
L3 Inbox in Mailbox I
[} unread Mail in Mailbox :l Date: Today — ) -
[ For Fallow Up in Mailbox &  JohnDoe [SPAM] / ttention - Read Carefully! Fri 27-02-09 2:03 PM 7KB
L[4 Sent Items in Mailbox
All Mail Folders
= @Parsnnal Folders i -
(&) Deleted Ttems
LA Drafis @ ttention - Read Carefully!
& [ Inbox -
| g Junk E-mail [5] ohn Doe
L3 outhox
L;]Sentltems From: ADMINISTRATION [mailto:securityffederalreservebank.us] ~
= LY Search Folders Sent: Tuesday, February 24, 2009 12:48 PM
L3 For Follow Up [13] Subject: Attention - Read Carefully!
L3 Large Mail
[ Unread Mail
# 5 Archive Folders FEDERAL RESERVE BANK
b Important:
.
You're getting this letter in connection with new directions
..ﬂ Hail issued by U.S. Treasury Department. The directions concern U.S.
Federal Wire and ACH online payments.
g Cn February 17, 2009 a large-scaled phishing attack started and
| Contacts has been still lasting. A great number of banks and credit unions
= iz affected by this attack and quantity of illegal bank transfers
-Yd Tasl_:s has reached an extremely high level.
__1 Boles TU.5. Ireasury Department, Federal Reserve, America Bankers
N - Association (ABA) and Federal Deposit Insurance Corporation (FDIC) @
[z =
LItem (17

Screenshot 6 — Email tagged as SPAM

e Accessing the inbox of the email account to which the test email
was sent and confirm that email subject includes [SPAM] in the
subject field.

3.4.4 GFIl MailEssentials Configuration

At this stage, your GFIl MailEssentials anti spam system is up and
running. All inbound email will be scanned by the anti spam filters
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Description

enabled by default. (See Table 1 - Anti spam filters enabled by default
below).

Enabled by
Default

An anti spam engine that determines if an

SpamRazer email is spam by using email reputation, v
message fingerprinting and content
analysis.
Director Stops email which is randomly generated
Y towards a server, mostly addressed to non- v
Harvesting :
existent users.
Blocks emails that contain links in the
PURBL message bodies pomtmg _to knO\_Nn _phlshmg v
sites or if they contain typical phishing
keywords.
SPF Stops email which is received from x
domains not authorized in SPF records
. Addresses that an email is sent to are
Auto-Whitelist automatically excluded from being blocked. v
Whitelists A custom list of safe email addresses v
Custom A custom list of blocked email users or v
blacklist domains.

Checks if the email received is from
senders that are listed on a public DNS v
blacklist of known spammers.

DNS blacklists

Stops emails which contain links to

SURBL domains listed on public Spam URI v
Blocklists such as sc.surbl.org
Header A module which analyses the individual
checkin fields in a header by referencing the SMTP v
9 and MIME fields
Keyword Spam messages are identified based on x
checking blocked keywords in the email title or body

Emails that have been received from
senders to whom emails have never been X
sent before.

New Senders

An anti spam technique where a statistical
probability index based on training from X
users is used to identify spam.

Bayesian
analysis

v' - Enabled by default

X - Not enabled by default
Table 1 - Anti spam filters enabled by default

By default, email classified as spam will be tagged (i.e. will include the
prefix [SPAM] in the subject field — see Screenshot 6 above). Although
enabled by default, email tagging is NOT the only anti spam filter
action that can be triggered on detection of email spam. Other actions
include re-routing of spam emails to specific folders and deletion of
spam emails.
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Anti spam filter actions

Je) £ = 8

Se| 8| g o

59| 38 =« g

. ko) Y= = b =

Filters 2% | 5¢ .g,g ]

S 2 Q ) Q

=5 ¢5 3 P

g1 87 =2 | &

= =

SpamRazer v v v v v v

Directory v v v v v v
Harvesting

PURBL v v v v v v

SPF v v v v v v

Whitelists @) @) @) O O O

Custom Blacklist v v v v v v

DNS blacklists v v v v v v

SURBL v v v v v v

Header Checking v v v v v v

Keyword Checking v v v v v v

New Senders v v v v X v

Bayesian Analysis v v v v v v

v’ - Action supported
X - Action not possible

O - Not applicable
Table 2 - Anti spam filter actions

Configuration of anti spam filters and actions is possible via the GFI
MailEssentials Configuration console. Additionally, through this
console you can also run reports and customize other product
features such as enable daily spam digest.

For guidelines on how to configure GFI MailEssentials functions and
features refer to the GFI MailEssentials Administration and
Configuration manual.

3.5 Installing on an email gateway or relay/perimeter server

Introduction

GFI MailEssentials can be installed:
e On a perimeter server (e.g. in a DM2)
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e As a mail relay server between the perimeter (gateway) SMTP
server and the recipients’ inboxes.

Both setups enable you to reduce unnecessary email traffic by using
your Active Directory resources (at a perimeter/gateway server level)
to drop connections for non-existent email recipients in incoming
email. This helps counter spamming techniques such as Directory
Harvest Attacks (a brute force type of attack used by spammers to find
valid/existent e-mail addresses at a domain). This structure stops the
majority of Spam from arriving at your Microsoft Exchange server.

Perimeter (Gateway)
SMTP Server

A
A Firewall
s, —~
Mail Server + e
GFI MailEssentials Internet

Figure 1 — A typical Perimeter SMTP Relay Server setup

3.5.1 Upgrades from earlier version

If you are currently using a previous version of GFI MailEssentials
(versions 9, 10, 11 and 12), you can upgrade your current installation
while at the same time retain all your existing configuration settings.

Important notes

¢ Upgrades cannot be undone i.e. you cannot downgrade to an
earlier version once you have installed the latest version.

e On upgrading an existing installation, licensing reverts to frial
version and a new fully purchased license key for the GFI
MailEssentials 14 is required. For more information on new license
keys, refer to: http://customers.gfi.com.

e You cannot change the installation path during GFI MailEssentials
upgrades.

e When upgrading from GFI MailEssentials 9, the current Bayesian
weights file will be upgraded to the new format used in GFI
MailEssentials 10 or later. The new format is more compact and
uses less memory. NO DATA WILL BE LOST.
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Upgrade procedure

1. Launch GFI MailEssentials installation on the server where your
earlier version of GFI MailEssentials is installed.

GFI MailEssentials E

€ | GFIMailEssertials version 12.0.2007.1203 is already installed. ‘fou must uninstall the existing version befare instaling GFI
__-/ MailEssentials version 12.0.2005.0324,

IMPORTAMNT: The new build requires the Microsaft .MET Framewaork 2.0 installed an this machine.

Do wou want ko uninstall the existing version of GFI MailEssentials?

Screenshot 7 - Confirm the upgrade

2. Click Yes to start the upgrade process and follow on-screen
instructions. For assistance refer to New installations section below.

3.5.2 New installations

Important notes

1. During installation, GFI MailEssentials restarts Microsoft Exchange
Server services. This is required to allow GFI MailEssentials
components to be registered and started.

2. Before starting installation, close any running Windows applications.

3. When installing GFI MailEssentials on a DMZ, we recommend you
use LDAP lookups to get the list of email users (required for user-
based configuration/rules e.g. disclaimers) from your SMTP server.
The AD of a DMZ usually will NOT include all the network users (email
recipients).

Pre-install actions

GFI MailEssentials uses the 1IS SMTP service as its SMTP Server
and therefore the [IS SMTP service must be configured to act as a
mail relay server. This is achieved as follows:

Step 1: Enable IIS SMTP Service

1. Go to Start » Control Panel » Add or Remove Programs »
Add/Remove Windows Components.

2. Select Internet Information Services (lIS) and click Details.

3. Select the SMTP Service option and click OK.

4. Click Next to finalize your configuration.

Step 2: Create SMTP domain(s) for email relaying

1. Go to Start » Control Panel » Administrative Tools.
2. Click on Internet Information Services (lIS) Manager.
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-

Internet Information Services

File  Ackion  View Help

«» B@EXFRE 2

?—'E Internet Information Services Damain Mame | Tvpe
= g Local computer %jsmith.gﬁ.cnm Local {Default)
=[] web Sites

ATest,gfi.com Fernoke
+ g Default web Site

—| % Default SMTP Yirtual Server

d % Carnains

ﬂ Current Sessions

2 Ikems

Screenshot 8 - Internet Information Services (IIS) Manager

3. In the left pane, expand the respective server node. Right click on
Default SMTP Virtual Server and select Properties.

4. Select the IP address currently assigned to your SMTP server and
click OK.

5. Expand the Default SMTP Virtual Server node.

6. Right click Domains and select New » Domain.

7. Select the Remote option and click Next.

8. Specify domain name (e.g. test.gfi.com) and click Finish.

Step 3: Enable email relaying to your Microsoft Exchange server:
1. Right click on the new domain (e.g. test.gficom) and select
Properties.

2. Select the Allow the Incoming Mail to be Relayed to this
Domain checkbox.
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domain.com Properties ﬂ |

General | Advanced I

% domain. com

Select the appropriate zettingz for pour remote domair.

V¥ Allow incoming mail to be relayed ta this domain

[T Send HELD instead of EHLD

Outbound Security....

Foute domain
" Use DMS to route ta this domain

% Forward all mail to smart host

[132.168.0.2]

Cancel Apply Help

Screenshot 9 - Configure the domain

3. Select the Forward all mail to smart host option and specify the
IP address of the server managing emails in this domain. IP address
must be enclosed in square brackets e.g. [123.123.123.123] so to
exclude them from all DNS lookup attempts.

4. Click OK to finalize your configuration.

Step 4: Secure your SMTP email-relay server

If unsecured, your mail relay server can be exploited and used as an
open relay for spam. To avoid this from happening, it is recommended
that you specifically define which mail servers can route emails
through this mail relay server (i.e. allow only specific servers to use
this email relaying setup). To achieve this:

1. Go to Start » Control Panel » Administrative Tools.

2. Click on Internet Information Services (lIS) Manager.

3. In the left pane, expand the respective server node. Right click on
Default SMTP Virtual Server and select Properties.

4. Click on the Access tab and select Relay.
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Relay Restrictions |

Select which computer may relay through this wirtual zerver:

& Only the list below
Al except the list below

Compriters:
Arcoess | IP Address [Mask] / Domain Mame
Add... | Hemeye |

¥ Allow all computers which successfully authenticate ta relay, regardless
of the lizt above.

| F, I Cancel Help

Screenshot 10 - Relay options

5. Select the Only the list below option and click Add.

6. Specify IP(s) of the mail server(s) that are allowed to route emails

through your mail relay server. You can specify:

e Single computer — i.e. Authorize one specific machine to relay
email through this server. Use the DNS Lookup button to lookup

an |IP address for a specific host.

e Group of computers — i.e. Authorize specific computer(s) to relay

emails through this server.

e Domain - Allow all computers in a specific domain to relay emails

through this server.

NOTE: The Domain option adds a processing overhead that can
degrade SMTP service performance. This is due to the reverse DNS
lookup processes triggered on all IP addresses (within that domain)

that try to route emails through this relay server.
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Step 5: Enable your Microsoft Exchange Server to route emails via mail
relay server/GFl MailEssentials

&Exchange System Manager !EI E
=il

’:‘L File Action Yiew Window Help

e | B@EEFRNB @

GFI MailEssentials

:L First Organization (Exchange)
-2 Glabal Settings Narme |

1 Recipients

- Servers There are no items to show in this view,
EI__] Connectors

- 137 BFI MailEssentials
70 Tools

-0 Falders

Screenshot 11 - Forwarding email to GFI MailEssentials machine

1. Launch Exchange System Manager.
2. Right click Connectors node and select New » SMTP Connector.

GFI MailEssentials Properties HE |

Addies: Space I Connected Routing Groups I Delivery Restrictions I
Content Restrictions | Delivery Optiohs | Advanced | Details |
General

: 47{ GFI MailE ssertials

a

" Use DMNS ta route to each address space on this connector

f* Forward all mail through this connector to the following zmart hosts

[132.1658.0.1280]

Local bridgeheads:
I

Sermver I Wirtual Server
TESTMCH-P1 Default SMTP Wirtual Server
Add.. | Hemoye |

[ Do not allow public folder referrals

Ok I Cancel | Aoy Help

Screenshot 12 - Specifying IP of GFI MailEssentials machine

3. Select the Forward all mail through this connector to the
following smart host option, and specify the IP of your mail relay
server within square brackets (i.e. the IP of the machine on which GFI

MailEssentials is installed) e.g. [123.123.1.123].
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Add Bridgehead |

SMTP wirtual gerver instances:

Server | Wirkual Server |

Default Sk TE Yirtual Server

k. I Cancel | Help |

Screenshot 13 - Adding a bridgehead

4. Click Add and select the virtual SMTP Server (i.e. the email relay

server on which GFI MailEssentials is running).

GFI MailEssentials Properties B |

Content R estrictions I Delivery Optionz I Advanced I Dretailz
General
Address Space | Connected Routing Groupz I Delivery Restrictions

Create, modify, or remove an address zpace.

Type | Addrezs | Cozt |
SMTP * 1
Add... I lEdifi.. Hemave

Connector scope
f*  Enftire organization

" Fouting group

[ Allow messages to be relayed to these domains

] I Cancel Sl Help

Screenshot 14 - Adding SMTP as address space

5. Click on the Address Space tab then click Add.
6. Select SMTP and click OK.
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7. Click OK to finalize your configuration. All emails will now be
forwarded to the GFI MailEssentials server.

Step 6: Update your domain MX record to point to mail relay server

Update the MX record of your domain to point to the IP of the new
mail relay server. If your DNS server is managed by your ISP, ask
your ISP to update the MX record for you.

If MX record is not updated all emails will be routed directly to your
email server - hence by-pass GFI MailEssentials anti spam filters.

Verify that MX record has been successfully updated

To verify whether MX record is updated do as follows:

1. Click Start » Run and type: Command

2. From the command prompt type in: nslookup

3. Type in: set type=mx

4. Specify your mail domain name.

The MX record should return a single IP address. This should be the
mail relay server |.P. address.

4| A WINNTY System32'.cmd.exe - nslookup =l I

Microsoft Windows 2WAA [Uersion 5.AA.21951 I!
{C> Copyright 1985-288@ Microsoft Corp.

C:xDocuments and Settingshadministrator.GHOST >nslookup
Default Server: server—ga
Address: 192.168.8.1

> et type=mx

> gatest.com

Server: server—ga
Address: 192.168.8.1

gatest.com MY preference = 1B, mail exchanger = gatest.com
gatest.com internet addressz = 192.168.8.153
>

Screenshot 15 - Checking the MX record of your domain

Step 7: Test your new mail relay server

Before proceeding to install GFI MailEssentials, verify that your new
mail relay server is working correctly by doing as follows:

Test IIS SMTP inbound connection via test email

1. Send an email from an ‘external’ account (e.g. internet email
account) to an internal email address/user.

2. Ensure that intended recipient received the test email in the
respective email client.

Test IIS SMTP outbound connection via test email

1. Send an email from an ‘internal’ email account to an external
account (e.g. internet email).

2. Ensure that the intended recipient/external user received the test
email.

NOTE: You can also use ‘Telnet’ to manually send the test email and
obtained more troubleshooting information. For more information refer
to: http://support.microsoft.com/support/kb/articles/Q153/1/19.asp
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GFI MailEssentials installation procedure

1. Logon your Microsoft Exchange Server machine using administrator
credentials.

2. Double click mailessentials14.exe (32-bit install) or
mailessentials14_x64.exe (64-bit install) accordingly.

3. Select preferred install language and click Next.

4. Select whether to check for newer versions/builds of GFlI
MailEssentials and click Next.

5. Read licensing agreement. To proceed with this installation select |
accept the license agreement and click Next.

6. Click Next to install in default location or click Browse to change
path.

7. Specify user details and enter license key. Click Next to continue.

8. Specify the email address where notifications (e.g. failed anti spam
filters, spam digests) are to be sent.

{5 GFI MailEssentials Setup & 3 |

Active Directory

Access to Active Directony users

[Dloes thiz zerver have accezs to all the email uzers in Active Directony?

o Tes, all email uzers are available on Active Directory, rules will be bazed on
Active Directony users.

Ma, | do not have Active Diectary ar my network, dogs not have access o
Active Directory [DME], miles will be based on SMTP email addrezzes.

GFI M ailE zzential=®

Screenshot 16 - Selecting SMTP mode or Active Directory mode

9. Specify whether GFI MailEssentials will get the list of email users
(required for user-based configuration/rules e.g. disclaimers) from
Active Directory or SMTP server. Click Next to continue.
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]‘E GFl MailE szentials Setup [ [

Microzoft Meszage Queuing Service

The GFl MailE zzentials Lizt Server requires the Microzoft Meszage Queuing Service
[MSkE]. The Meszaging Queuing Service iz & scalable system service developed by
ticrozoft to enable high wolume event proceszing. Thiz service i included with eveny
Windows 2000, %P and 2003 verzionz, although not abways inztalled by default

The GFI MailE zzentialz installation can install MSMO for you, To complete thiz process,
wou will reguire the windows 2000, =P ar 2003 CD .

We recommend to inztall the MSMO at this point howeser pou can also install it at a later
stage. Fleaze note that you cannot uze the List Server without kS kGL

Do pou want toingtall the MSMO eervice now?

GFI MailE zzentials®

¢ Back Mewt = | Cancel

Screenshot 17 - Installing Microsoft Message Queuing Service

10. If Microsoft Message Queuing Services (MSMQ) is not installed
then the dialog in the above screenshot will open. To be able to use
list servers (i.e. distributions lists), select Yes to install MSMQ.

]'E GFI MaillEzsentials for Exchange/SMTP Setup M= E3

Confirm inbound email domains

Click Mext to begin inztallation.

The following inbound email domains were found:

gfi.co.uk
qgfi.cam
gfimalta.com
lozalhost

& GF| MailEzzentialz can only proceszs email: addrezzed to the domaing
listed abowve. Therefare, i SPAM email iz zent to a domain not listed
above it will not be blocked.

To further configure the above domainz, open the GFl Mailk szentialz
configuration, right click on the General node and select Properties

GFI b ailE zzential=®

< Back Mext » | Cancel

Screenshot 18 - Configure your inbound email domain

11. Setup will now display the list of inbound email domains detected.
Verify that all inbound email domains to be protected against spam
are listed. Take note of any changes required for post-installation and
click Next.
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NOTE: You can modify the list of inbound email domains ONLY post-
install. For more information refer to the Confirm domains to defend
against spam section starting on page 30 in this manual.

12. Click Finish to finalize your installation. On completion, setup will:
e Ask you to restart the SMTP service.

IMPORTANT: Failing to restart the SMTP service will
negatively affect anti spam filtering and email flow.

e Check whether Microsoft XML engine is installed. This is
automatically installed if not found on UK/US English OS. For
other OS languages, this has to be manually downloaded and
installed. Microsoft XML engine can be downloaded from:
http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e Prompt you to launch the Quick Start Guide. This is a set of
instructions that will guide you through the configuration settings
required post-install/for first use (Recommended).

13. At this stage, GFI MailEssentials is installed. You must now
configure GFI MailEssentials for first use. For instructions refer to the
next section titled Post-install actions.

3.5.3 Post-install actions

To ensure that your GFI MailEssentials anti spam system is effectively
up and running you must perform the following post-install actions:

Step 1: Launch GFI MailEssentials Configuration console

Click on Start » All Programs » GFl MailEssentials » GFI
MailEssentials Configuration.

Step 2: Verify current DNS Server settings

1. Right click Anti spam node and select Properties.

2. Click on the DNS Server tab. Verify the DNS server details
automatically detected during install.

3. To specify a different DNS Server, select Use the following DNS
server and specify details.

4. Click Test to check your newly added DNS server settings.
5. Click OK to finalize your configuration.

Step 3: Confirm domains to defend against spam

NOTE: ONLY the inbound email domains configured in GFI
MailEssentials will be protected against spam.

1. Right click General node and select Properties.

2. Click on the Inbound Email Domains tab and ensure that all
required inbound domains are listed in the Inbound domains field.

3. To specify additional domains, click Add... and enter inbound email
domain details.

4. Click OK button to finalize your configuration.
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Step 4: Enable Directory Harvesting

This filter uses Active directory or LDAP lookups to verify whether
inbound emails are addressed to legitimate ‘internal’ email accounts.
To enabile this filter:

1. Right click Anti spam node and select Directory Harvesting »
Properties.

2. Select Enable directory harvesting protection.
3. Select the lookups method to be used:

e Use native Active Directory lookups option — Select this option
if during installation you selected to get the list of email users from
Active Directory (see Installation Procedure section above — step
9).

e Use LDAP lookups — Select this option if during installation you
selected to get the list of email users from SMTP server using
LDAP (see Installation Procedure section above — step 9). In
addition:

0 Unselect the Anonymous bind option if your LDAP server
requires authentication

Enter the authentication details using Domain\User format.
0 Click Test button to test your LDAP configuration settings.

Step 5: Configure whitelists

Whitelists enable you to specify lists of ‘friendly’ email domains, email
addresses or |IP addresses.

WARNING: USE THIS FEATURE WITH CAUTION. Entries in this list
will not be scanned for spam and will bypass all anti spam filtering.

1. Right click Anti spam node and select Whitelist » Properties.
2. Click on the Whitelist tab.

3. Click Add... and specify domains/email addresses or IP addresses
to whitelist.

4. Click OK to finalize your configuration.

Step 6: Test your anti spam system

GFI MailEssentials is now ready to start managing spam. To verify
that anti spam is working properly:

1. Clicking Start » All Programs » GFl MailEssentials » GFI
MailEssentials Dashboard.

2. Using an external email account (for example webmail, hotmail or
Gmail), create a new email and key in “100% free” as the subject.

3. Send the email to one of your internal email accounts. GFI
MailEssentials will tag this email as spam by adding the tag [SPAM] to
the email ‘subject’ field.

4. Allow some time for email delivery and confirm that email spam
tagging is working by:
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[ GFI MailEssentials Dashboard

Eile

Cptions  Help

tatistics I PZE Logging I

=] B3

— Statuz of key services
E@'I GFI b ailE zzential: M anaged Attendant Service iz Runhing
L@I GFl MailE ssentials Legacy Attendant Service is Running
I@ GFl MailE szential: Enterprize Transfer Agent iz Running

'@I GFI List Server iz Running
'Q' GFl MailE szentials POP2Eschange Service is Running
"@I 115 Admit Service iz Runnhing

MTA Logging
Proceszed Time | Filker Lewvel | Sender | Recipients | Subject il
= 2/26/2003 3:00:24 PM FullEmal  "John Doe" <johndoe@ hotmail.coms johhdoe@domain.com 100%% Free

=T

.

4 |

Screenshot 19 - Testing your anti spam system

o Checking the GFI MailEssentials Dashboard. Use the Status tab to
view the status of key GFI MailEssentials services and email
processing activity. Receipt and processing status of this email is
logged in the MTA logging window.

Inbox - Microsoft Outlook
! Fle Edt Actions  Help Type
E_a_'mew =& 3 * | ,_;ﬁ Reply ;ﬂREpbeoAll __'3 Forward | g'_ﬁSend!Regewe ~ | ‘i.';;Fmd & | 3

View Go Tools

Favorite Folders |Received

Y [ @ From Subject

L3 Inbox in Mailbox

[} unread Mail in Mailbox
[ For Fallow Up in Mailbox
L= Sent Items in Maibox

All Mail Folders

= %ﬁ Personal Folders i -
(&) Deleted Ttems [
LA Drafis @ ttention - Read Carefully!
H [~ Inbox o
| g Junk E-mail [5] : ohn Doe
L3 outhox
(= Sent Items From: ADMINISTRATION [mailto:security@federalreservebank.us] ~
= LL'%Sfan:h Folders Sent: Tuesday, February 24, 2009 12:48 PM T
'—4 For Follow Up [13] Subject: Attention - Read Carefully!
L3 Large Mail
[ Unread Mail
& 5§ Archive Folders

= Date: Today
e

John Doe [SPAM] / ttention - Read Carefuly! Fri 27-02-09 2:03 PM 7KB

FEDERAL RESERVE BANK

b Important:
v
You're getting this letter in connection with new directions
..ﬂ Hail issued by U.S. Treasury Department. The directions concern U.S.
Federal Wire and ACH online payments.
] calendar }
g Cn February 17, 2009 a large-scaled phishing attack started and
| Contacts has been still lasting. A great number of banks and credit unions
= iz affected by this attack and quantity of illegal bank transfers
-Yd Tasl:s_ has reached an extremely high level.
__1 Boles TU.5. Ireasury Department, Federal Reserve, America Bankers
N @ ﬁ » Association (ABA) and Federal Deposit Insurance Corporation (FDIC) @
[ d gd L =

11tem

[

Screenshot 20 — Email tagged as SPAM

e Accessing the inbox of the email account to which the test email
was sent and confirm that email subject includes [SPAM] in the
subject field.

3.5.4 GFI MailEssentials Configuration

At this stage, your GFIl MailEssentials anti spam system is up and
running. All inbound email will be scanned by the anti spam filters
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enabled by default (see Table 3 - Anti spam filters enabled by default
below).

Description

Enabled by
Default

SpamRazer

Directory
Harvesting

PURBL

SPF

Auto-Whitelist

Whitelists

Custom
blacklist

DNS blacklists

SURBL

Header
checking

Keyword
checking

New Senders

Bayesian
analysis

An anti spam engine that determines if an
email is spam by using email reputation,
message fingerprinting and content
analysis.

Stops email which is randomly generated
towards a server, mostly addressed to non-
existent users.

Blocks emails that contain links in the
message bodies pointing to known phishing
sites or if they contain typical phishing
keywords.

Stops email which is received from
domains not authorized in SPF records

Addresses that an email is sent to are
automatically excluded from being blocked.

A custom list of safe email addresses

A custom list of blocked email users or
domains.

Checks if the email received is from
senders that are listed on a public DNS
blacklist of known spammers.

Stops emails which contain links to
domains listed on public Spam URI
Blocklists such as sc.surbl.org

A module which analyses the individual
fields in a header by referencing the SMTP
and MIME fields

Spam messages are identified based on
blocked keywords in the email title or body

Emails that have been received from
senders to whom emails have never been
sent before.

An anti spam technique where a statistical
probability index based on training from
users is used to identify spam.

X

v' - Enabled by default
X - Not enabled by default

Table 3 - Anti spam filters enabled by default

By default, email classified as spam will be tagged (i.e. will include the
prefix [SPAM] in the subject field - see Screenshot 20 above).
Although enabled by default, email tagging is NOT the only anti spam
filter action that can be triggered on detection of email spam (see
Table 4 - Anti spam filter actions below). Other actions include re-
routing of spam emails to specific folders and deletion of spam emails.
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Anti spam filter actions
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= =

SpamRazer v v v v v v
Directory Harvesting v 4 v 4 v v
PURBL v v v v v v
SPF 7 7 v v v v
Whitelists O O O O O O
Custom Blacklist v v 4 v v v
DNS blacklists v 4 v v v v
SURBL v v v v v v
Header Checking v v v v v v
Keyword Checking v v 4 v v v
New Senders v v v v X v
v v v v v v

Bayesian Analysis

v’ - Action supported
X - Action not possible

O - Not applicable
Table 4 - Anti spam filter actions

Configuration of anti spam filters and actions is possible via the GFI
MailEssentials Configuration console. Additionally, through this
console you can also run reports and customize other product
features such as enable daily spam digest.

For guidelines on how to configure GFI MailEssentials functions and
features refer to the GFI MailEssentials Administration and
Configuration manual.

3.6 Installing on Microsoft Exchange 2000/2003 cluster

Introduction

A cluster is a group of servers, technically known as nodes, working
collectively as a single server. Such environment provides high
availability and fail over mechanisms to ensure constant availability of
resources and applications including email infrastructures. If one of

34 « 2BInstallation for Microsoft Exchange 2000 & 2003 Getting Started Guide



the nodes in the cluster fails/is not available, resources and
applications switch to another cluster node.

A Microsoft Exchange cluster can be set up in one of 2 modes:
active/active or active/passive. GFl MailEssentials supports ONLY
active/passive clusters. In an active/passive cluster, a ‘failover
mechanism ensures that whenever an active cluster fails, one of the
available passive nodes becomes active (i.e. takes over the role of the
failed node).

In view of the way clusters work, GFI MailEssentials must be installed
on all servers/cluster nodes in order to ensure uninterrupted email
spam management. GFl MailEssentials installation in a Microsoft
Exchange 2000/2003 cluster is a 4-tier process:

e Process 1: Install GFI MailEssentials on the Active cluster node.

e Process 2: Stop the GFI MailEssentials Legacy Attendant and the
GFl POP2Exchange cluster resources and move the Exchange
Virtual Server cluster group resource to a passive/other node.

e Process 3: Install GFI MailEssentials on another cluster node.

e Process 4: Add specific GFI MailEssentials services to the
Exchange Virtual Server cluster resource group

Repeat Processes 2, 3 and 4 above for the remaining passive node(s)
in the cluster.

3.6.1 Upgrade from earlier version

If you are currently using a previous version of GFI MailEssentials
(versions 9, 10, 11 and 12), you can upgrade your current installation
while at the same time retain all your existing configuration settings.

Pre-upgrade actions

None

Important notes

e Upgrades cannot be undone i.e. you cannot downgrade to an
earlier version once you have installed the latest version.

e On upgrading an existing installation, licensing reverts to trial
version and a new fully purchased license key for the GFl
MailEssentials 14 is required. For more information on new license
keys, refer to: http://customers.gfi.com

e You cannot change the installation path during GFl MailEssentials
upgrades.

e When upgrading from GFI MailEssentials 9, the current Bayesian
weights file will be upgraded to the new format used in GFI
MailEssentials 10 or later. The new format is more compact and
uses less memory. NO DATA WILL BE LOST.

e When upgrading in a Microsoft Exchange cluster environment, all
instances of GFI MailEssentials must be upgraded i.e. GFI
MailEssentials must be upgraded on all cluster nodes/servers
making part of the cluster.
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Upgrade procedure

1. Launch GFI MailEssentials installation on the server where your
earlier version of GFI MailEssentials is installed.

GFI MailEssentials E

€ | GFIMailEssertials version 12.0.2007.1203 is already installed. ‘fou must uninstall the existing version befare instaling GFI
__-/ MailEssentials version 12.0.2005.0324,

IMPORTAMNT: The new build requires the Microsaft .MET Framewaork 2.0 installed an this machine.

Do wou want ko uninstall the existing version of GFI MailEssentials?

Screenshot 21 - Confirm the upgrade

2. Click Yes to start the upgrade process and follow on-screen
instructions. For assistance refer to the Installation procedure chapter
in the section below.

3.6.2 New installations

Important notes

1. Only active/passive cluster setups are supported.
2. Before starting installation, close any running Windows applications.

3. Before starting installation, Microsoft Exchange Server 2000/2003
needs to be installed in clustered mode.

4. Before starting installation ensure that you have a Microsoft Virtual
Server cluster group resource with a physical disc cluster available.

Pre-install actions

Create Microsoft Virtual Server cluster group resource

Before you can create an Exchange Virtual Server in a Windows
Server cluster, you must first create a cluster resource group. This is
the unit of failover in a Windows Server cluster. When Exchange
Server is running in a Windows Server cluster, the cluster resource
group that contains the Exchange cluster resources is referred to as
an Exchange Virtual Server.

To create a resource group for an Exchange Virtual Server in a
Windows Server cluster do as follows:

1. Start Cluster Administrator. On prompt, specify cluster details (e.g.
name) or click the browse button to select cluster in which you want
to create an Exchange Virtual Server.

2. In the console tree, right-click Groups and select New » Group.

3. In the New Group Wizard that starts automatically, specify a name
for the new cluster group, and click Next.

4. Click Finish to finalize your configuration. This new group object is
displayed under Groups in Cluster Administrator.
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Installation procedure

Step 1 - Install GFI MailEssentials in the shared hard drive on active
server

1. Logon on the active node of your Microsoft Exchange cluster using
administrator credentials.

2. Double click mailessentials14.exe (32-bit install) or
mailessentials14_x64.exe (64-bit install) accordingly.

3. Select install language and click Next.

4. Select whether to check for newer versions/builds of GFI
MailEssentials and click Next.

5. Read licensing agreement. To proceed with the installation select |
accept the license agreement and click Next.

6. Click Next to install in default location or click Browse to change
path.

7. Specify user details and enter license key. Click Next to continue.

8. Specify the email address where notifications (e.g. failed anti spam
filters, spam digests) are sent.

i'._gl,'- GFI MailEssentials Setup =] |

Active Directory

Access to Active Directary users

[loes thiz zerver have accezs to all the email uzers in Active Directom?

5 Tes, all email uzers are available on Active Directory, wiles will be bazed on
Active Directony users.

Ma, | do not have dctive Directory or my network, does not have access o
Active Directary [DME], mules will be based on SMTP email addreszses.

GF] MailEzzentialz®

Cancel |

< Back

Screenshot 22 - Selecting SMTP mode or Active Directory mode

9. Specify whether GFI MailEssentials will get the list of email users
(required for user-based configuration/rules e.g. disclaimers) from
Active Directory or SMTP server. Click Next to continue.
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]‘E GFl MailE szentials Setup [ [

Microzoft Meszage Queuing Service

The GFl MailE zzentials Lizt Server requires the Microzoft Meszage Queuing Service
[MSkE]. The Meszaging Queuing Service iz & scalable system service developed by
ticrozoft to enable high wolume event proceszing. Thiz service i included with eveny
Windows 2000, %P and 2003 verzionz, although not abways inztalled by default

The GFI MailE zzentialz installation can install MSMO for you, To complete thiz process,
wou will reguire the windows 2000, =P ar 2003 CD .

We recommend to inztall the MSMO at this point howeser pou can also install it at a later
stage. Fleaze note that you cannot uze the List Server without kS kGL

Do pou want toingtall the MSMO eervice now?

GFI MailE zzentials®

¢ Back Mewt = | Cancel

Screenshot 23 - Installing Microsoft Message Queuing Service

10. If Microsoft Message Queuing Services (MSMQ) is not installed
then the dialog in the above screenshot will open. To be able to use
list servers (i.e. distributions lists), select Yes to install MSMQ.

]'E GFI MaillEzsentials for Exchange/SMTP Setup M= E3

Confirm inbound email domains

Click Mext to begin inztallation.

The following inbound email domains were found:

gfi.co.uk
qgfi.cam
gfimalta.com
lozalhost

& GF| MailEzzentialz can only proceszs email: addrezzed to the domaing
listed abowve. Therefare, i SPAM email iz zent to a domain not listed
above it will not be blocked.

To further configure the above domainz, open the GFl Mailk szentialz
configuration, right click on the General node and select Properties

GFI b ailE zzential=®

< Back Mext » | Cancel

Screenshot 24 - Configure your inbound email domain

11. Setup will now display the list of inbound email domains detected.
Verify that all inbound email domains to be protected against spam
are listed. Take note of any changes required for post-installation and
click Next.
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NOTE: You can modify the list of inbound email domains ONLY post-
install. For more information refer to the Confirm domains to defend
against spam section in this manual.

12. Click Finish to finalize your installation. On completion, setup will:

e Ask you to restart the SMTP service. Failing to restart the SMTP
service will negatively affect anti spam filtering and email flow.

e Check whether Microsoft XML engine is installed. This is
automatically installed if not found on UK/US English OS. For
other OS languages, this has to be manually downloaded and
installed. Microsoft XML engine can be downloaded from:

http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e Prompt you to launch the Quick Start Guide. This is a set of
instructions that will guide you through the GFI MailEssentials
configuration settings required post-install/for first use.

Step 2 — Move the Exchange Virtual Server cluster group

1. Go to Control Panel » Administrative Tools » Cluster
Administrator.

2. Stop the GFI MailEssentials Legacy Attendant and the GFI
POP2Exchange cluster resources.

3. Move the Exchange Virtual Server cluster group resource to
another node.

Step 3 — Install GFI MailEssentials on a passive server

1. Logon on the passive node of your Microsoft Exchange cluster
using administrator credentials.

2. Double click mailessentials14.exe (32-bit install) or
mailessentials14_x64.exe (64-bit install) accordingly.

3. Select install language and click Next.

4. Select whether to check for newer versions/builds of GFlI
MailEssentials and click Next.

5. Read licensing agreement. To proceed with the installation select |
accept the license agreement and click Next.

6. Click Next to install in default location or click Browse to change
path.

7. Specify user details and enter license key. Click Next to continue.

8. Specify the email address where notifications (e.g. failed anti spam
filters, spam digests) are sent.
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]‘E GFI MailEssentials Setup M= E3
>

Active Directory

Arccess to Active Directon) users

Does this zerver have access to all the email users in Active Directany’?

o Tes, all email users are available on Active Directory, wles will be based on
Active Directon users.

Ma, | do not have Active Directary or my network, does not have access to
Active Directony [DME], riles will be bazed on SMTP email addreszes.

GFI MailE zzentials®

< Back Cancel

Screenshot 25 - Selecting SMTP mode or Active Directory mode

9. Specify whether GFI MailEssentials will get the list of email users
(required for user-based configuration/rules e.g. disclaimers) from
Active Directory or SMTP server. Click Next to continue.

fi# GFI MailEssentials Setup [ [
Microzoft Message Queuing Service }r {
M

The GFl MailE zzentials Lizt Server requires the Microzoft Meszage Queuing Service
[MSkE]. The Meszaging Queuing Service iz & scalable system service developed by
ticrozoft to enable high wolume event proceszing. Thiz service i included with eveny
Windows 2000, %P and 2003 verzionz, although not abways inztalled by default

The GFI MailE zzentialz installation can install MSMO for you, To complete thiz process,
wou will reguire the windows 2000, =P ar 2003 CD .

We recommend to inztall the MSMO at this point howeser pou can also install it at a later
stage. Fleaze note that you cannot uze the List Server without kS kGL

Do pou want toingtall the MSMO eervice now?

GFI MailE zzentials®

¢ Back Mewt = | Cancel

Screenshot 26 - Installing Microsoft Message Queuing Service

10. If Microsoft Message Queuing Services (MSMQ) is not installed
then the dialog in the above screenshot will open. To be able to use
list servers (i.e. distributions lists), select Yes to install MSMQ.
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i'é" GFI MailEzzentialz for ExchangefSMTP Setup !E[E

Confirm inbound email domains }1-‘ {:
i

Click Mest to begin installation.

The follawing inbound emall domains were found:

gfi.co.uk
gfi.com
gfimalta.conm
lozalhost

& GFl MailEzzentialz can only process emails addressed to the domaing
lizted above. Therefore, if SPAk email iz ent to a domain not lizted
above it will not be blocked.

To further configure the above domainz, open the GFI Mailk zzentialz
cohfiguration, nght click on the General node and select Properties

GFI MailE zzentials®

¢ Back | Mext » I Cancel

Screenshot 27 - Configure your inbound email domain

11. Setup will now display the list of inbound email domains detected.
Verify that all inbound email domains to be protected against spam
are listed. Take note of any changes required for post-installation and
click Next.

NOTE: You can modify the list of inbound email domains ONLY post-
install. For more information refer to the Confirm domains to defend
against spam section starting on page 43 in this manual.

12. Click Finish to finalize your installation. On completion, setup will:

e Ask you to restart the SMTP service. Failing to restart the SMTP
service will negatively affect anti spam filtering and email flow.

e Check whether Microsoft XML engine is installed. This is
automatically installed if not found on UK/US English OS. For
other OS languages, this has to be manually downloaded and
installed. Microsoft XML engine can be downloaded from:

http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e Prompt you to launch the Quick Start Guide. This is a set of
instructions that will guide you through the GFI MailEssentials
configuration settings required post-install/for first use.

Step 4 - Add specific GFl MailEssentials services to the Exchange
Virtual Server cluster resource group

When installing GFI MailEssentials in a clustered windows
environment, the product services described below are not
automatically included in a cluster resource group. Consequently, if
the cluster node on which GFI MailEssentials is running fails, these
product services are not moved to another cluster node along with the
resource group and they will not be restarted on the new node. As a
result, GFl MailEssentials will not start up properly after a failover in a
cluster environment.
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The services to be added to the Exchange Virtual Server cluster
resource group are:

Service Name: gfiasmlhost

o Display name: GFI MailEssentials Managed Attendant Service
e Dependencies: None

o Start Parameters: None

¢ Registry Replication: None

Service Name: listserv

e Display Name: GFl MailEssentials List Server

e Dependencies: GFl MailEssentials Legacy Attendant
o Start Parameters: None

¢ Registry Replication: None

Service Name: GFIMETRXSVC

o Display Name: GFl MailEssentials Enterprise Transfer Service
e Dependencies: GFl MailEssentials Legacy Attendant

o Start Parameters: None

¢ Registry Replication: None

To add these services:

1. Go to Control Panel » Administrative Tools » Cluster
Administrator.

2. In the tree view on the left hand side of the ‘Cluster Administrator
console’, expand the cluster root node and then the Groups node.

3. Right-click on the Exchange Virtual Server cluster group resource
to bring up the pop-up menu.

4. Scroll down to the New menu item to expand it, and select
Resource to bring up the New Resource wizard.

5. Enter the service display name in the ‘Name’ and ‘Description’
fields. Select ‘Generic Service’ as Resource Type and select the
Exchange Virtual Server cluster group resource as the group to which
the new resource will be added. Click Next.

6. In the Possible Owners dialog, add the nodes of the Exchange
cluster to the list of preferred owners. Click Next.

7. Select the resource dependencies in the Dependencies dialog.
Click Next.

8. In the ‘Generic Service Parameters’ dialog, enter the service name,
and leave the start parameters text box empty. Click Next.

9. Click Finish to finalize your configuration. Do not add any keys in
the ‘Registry Replication’ dialog.

10. Repeat from step 3 to 8 above for each service mentioned above.
11. Right-click on the newly added resource(s) and select Bring

Online to enable services. These resources are visible in the list of
cluster resources of the Exchange Virtual Server cluster.
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3.6.3 Post-install actions

At this stage, GFI MailEssentials is installed. You must now configure
GFI MailEssentials for first use.

To ensure that your GFI MailEssentials anti spam system is effectively
up and running do as follows:

Step 1: Launch GFI MailEssentials Configuration console

Click on Start » All Programs » GFl MailEssentials » GFI
MailEssentials Configuration.

Step 2: Verify current DNS Server settings

1. Right click Anti spam node and select Properties.

2. Click on the DNS Server tab. Verify the DNS server details
automatically detected during install.

3. To specify a different DNS Server, select Use the following DNS
server and specify details.

4. Click Test to check your newly added DNS server settings.
5. Click OK to finalize your configuration.

Step 3: Confirm domains to defend against spam

NOTE: ONLY the inbound email domains configured in GFI
MailEssentials will be protected against spam.

1. Right click General node and select Properties.

2. Click on the Inbound Email Domains tab and ensure that all
required inbound domains are listed in the Inbound domains field.

3. To specify additional domains, click Add... and enter inbound email
domain details.

4. Click OK button to finalize your configuration.

Step 4: Enable Directory Harvesting

This filter uses Active directory or LDAP lookups to verify whether
inbound emails are addressed to legitimate ‘internal’ email accounts.
To enabile this filter:

1. Right click Anti spam node and select Directory Harvesting »
Properties.

2. Select Enable directory harvesting protection.
3. Select the lookups method to be used:

e Use native Active Directory lookups option — Select this option
if during installation you selected to get the list of email users from
Active Directory (see Installation Procedure section above — step
9).

e Use LDAP lookups — Select this option if during installation you
selected to get the list of email users from SMTP server using
LDAP (see Installation Procedure section above — step 9). In
addition:

0 Unselect the Anonymous bind option if your LDAP server
requires authentication
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0 Enter the authentication details using Domain\User format.
0 Click Test button to test your LDAP configuration settings.

Step 5: Configure whitelists

This filter allows you to specify lists of ‘friendly’ email domains, email
addresses or |IP addresses.

WARNING: USE THIS FEATURE WITH CAUTION. Entries in this list
will not be scanned for spam and will bypass all anti spam filtering.

1. Right click Anti spam node and select Whitelist » Properties.
2. Click on the Whitelist tab.

3. Click Add... and specify domains/email addresses or IP addresses
to whitelist.

4. Click OK to finalize your configuration.

Step 6: Test your anti spam system

GFI MailEssentials is now ready to start managing spam. To verify
that anti spam is working properly:

1. Clicking Start » All Programs » GFl MailEssentials » GFI
MailEssentials Dashboard.

2. Using an external email account (for example webmail, hotmail or
Gmail), create a new email and key in “100% free” as the subject.

3. Send the email to one of your internal email accounts. GFl
MailEssentials will tag this email as spam by adding the tag [SPAM] to
the email ‘subject’ field.

4. Allow some time for email delivery and confirm that email spam
tagging is working by:

3 GFI MailEssentials Dashboard =]

Eile  Options  Help

I Statisticsl FZE Loggingl

— Statug of key services
Q:’) GFl MailE szentials M anaged Attendant Service iz Runhing ﬂ GFI List Server iz Running

{‘) GFl MailE szential: Legacy Attendant Service iz Running -{':j- GFl MailE szential: POP2Exchange Service is Running
ﬂ GFl MailE szentials Enterprize Transfer Agent iz Running é) 115 Admin Service is Running

MTA Logging
Processzed Time I Filker Level I Sender I Recipients I Subject AI
=4 22642009 2:00:24 PM FullEmal  “John Dog" <johndoe® hotmail coms johindoe@domain. com 100%% Free

=
J | o

Screenshot 28 - Testing your anti spam system

e Checking the GFI MailEssentials Dashboard. Use the Status tab to
view the status of key GFI MailEssentials services and email
processing activity. Receipt and processing status of this email is
logged in the MTA logging window.
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Screenshot 29 — Email tagged as SPAM

e Accessing the inbox of the email account to which the test email
was sent and confirm that email subject includes [SPAM] in the

subject field.

3.6.4 GFI MailEssentials Configuration

At this stage, your GFI MailEssentials anti spam system is up and
running. All inbound email will be scanned by the anti spam filters
enabled by default (see Table 5 - Anti spam filters enabled by default

below).

SpamRazer

Directory
Harvesting

PURBL

SPF

Auto-Whitelist

Description
Default

An anti spam engine that determines if an
email is spam by using email reputation,
message fingerprinting and content
analysis.

Stops email which is randomly generated
towards a server, mostly addressed to non-
existent users.

Blocks emails that contain links in the
message bodies pointing to known phishing
sites or if they contain typical phishing
keywords.

Stops email which is received from
domains not authorized in SPF records

Addresses that an email is sent to are
automatically excluded from being blocked.
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Whitelists

Custom
blacklist

DNS blacklists

SURBL

Header
checking

Keyword
checking

New Senders

Bayesian
analysis

A custom list of safe email addresses

A custom list of blocked email users or
domains.

Checks if the email received is from
senders that are listed on a public DNS
blacklist of known spammers.

Stops emails which contain links to
domains listed on public Spam URI
Blocklists such as sc.surbl.org

A module which analyses the individual
fields in a header by referencing the SMTP
and MIME fields

Spam messages are identified based on
blocked keywords in the email title or body

Emails that have been received from
senders to whom emails have never been
sent before.

An anti spam technique where a statistical
probability index based on training from
users is used to identify spam.

X

v’ - Enabled by default
X - Not enabled by default

Table 5 - Anti spam filters enabled by default

By default, email classified as spam will be tagged (i.e. will include the
prefix [SPAM] in the subject field - see Screenshot 29 above).
Although enabled by default, email tagging is NOT the only anti spam
filter action that can be triggered on detection of email spam (see
Table 6 - Anti spam filter actions below). Other actions include re-
routing of spam emails to specific folders and deletion of spam emails.

SpamRazer

Directory Harvesting

PURBL

SPF

Whitelists

Anti spam filter actions

Forward to specific
email address
Move to subfolder in
user mailbox

O X N [|X X
O X N N N
O XN N [X X
O X XN |X X

Move to junk mail
folder

SN \ove to specific folder

O X N N s
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Custom Blacklist
DNS blacklists
SURBL

Header Checking

ANEER N N NN

Keyword Checking

AN N N N A N N

New Senders X

SN N N N N N
DI N N N N N
AN N N N VS
AN N NN Y N

Bayesian Analysis v v

v' - Action supported
X - Action not possible

O - Not applicable
Table 6 - Anti spam filter actions

Configuration of anti spam filters and actions is possible via the GFI
MailEssentials Configuration console. Additionally, through this
console you can also run reports and customize other product
features such as enable daily spam digest.

For guidelines on how to configure GFI MailEssentials functions and
features refer to the GFI MailEssentials Administration and
Configuration manual.

3.7 Installing on IIS cluster

Introduction

A cluster is a group of servers, technically known as nodes, working
collectively as a single server. Such environment provides high
availability and fail over mechanisms to ensure constant availability of
resources and applications including email infrastructures. If one of
the nodes in the cluster fails/is not available, resources and
applications switch to another cluster node.

A Microsoft Exchange cluster can be set up in one of two modes:
active/active or active/passive. GFl MailEssentials supports ONLY
active/passive clusters. In an active/passive cluster, a ‘failover
mechanism ensures that whenever an active cluster fails, one of the
available passive nodes becomes active (i.e. takes over the role of the
failed node).

In view of the way clusters work, GFI MailEssentials must be installed
on all servers/cluster nodes in order to ensure uninterrupted email
spam management. GFI MailEssentials installation in an IIS cluster is
a 3-tier process:

e Process 1: Install GFI MailEssentials on the Active cluster node.
o Process 2: Install GFI MailEssentials on another cluster node.

e Process 3: Add specific GFI MailEssentials services to the
Exchange Virtual Server cluster resource group.

Repeat Processes 2, 3 and 4 above for the remaining passive node(s)
in the cluster.
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3.7.1 Upgrade from earlier version

If you are currently using a previous version of GFI MailEssentials
(version 12), you can upgrade your current installation while at the
same time retain all your existing configuration settings.

Pre-upgrade actions

None

Important notes

e Upgrades cannot be undone i.e. you cannot downgrade to an
earlier version once you have installed the latest version.

e On upgrading an existing installation, licensing reverts to trial
version and a new fully purchased license key for the GFI
MailEssentials 14 is required. For more information on new license
keys, refer to: http://customers.gfi.com

e You cannot change the installation path during GFI MailEssentials
upgrades.

e When upgrading in a Microsoft Exchange cluster environment, all
instances of GFI MailEssentials must be upgraded i.e. GFI
MailEssentials must be upgraded on all cluster nodes/servers
making part of the cluster.

Upgrade procedure

1. Launch GFI MailEssentials installation on the server where your
earlier version of GF| MailEssentials is installed.

GFI MailEssentials [ =]

9 GFl MailEssentials version 12.0.2007.1203 is already installed. ou must uninstall the existing wversion before instaling GFI
__-/ MailEssentials version 12.0,2005.0324,

IMPORTANT: The new build requires the Microsoft \NET Framework 2.0 installed on this machine.

Do wou wank to uninstall the exisking version of GFI MailEssentials?

Screenshot 30 - Confirm the upgrade

2. Click Yes to start the upgrade process and follow on-screen
instructions. For assistance refer to Installation procedure chapter in
the section below.

3.7.2 New installations

Important notes

1. Only active/passive cluster setups are supported.
2. Before starting installation, close any running Windows applications.

3. Before starting installation, Microsoft Exchange Server 2000/2003
needs to be installed in clustered mode.

4. Before starting installation ensure that you have a Generic Service
cluster group resource for the SMTP Service and a physical disc
cluster resource available.
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Pre-install actions

Create a new resource
1. Open Cluster Administrator.
2. In the console tree, double-click Groups folder.

3. In the details pane, click the group to which you want the resource
to belong.

4. On the File menu, select to New, and then click Resource.

5. In the New Resource Wizard, type the appropriate information in
Name and Description, click the appropriate information in Resource
type and Group, and click Next.

6. Add or remove possible owners of the resource, and click Next.

7. To add dependencies, under Available resources, click a resource,
and then click Add.

Or, to remove dependencies, under Resource dependencies, click a
resource, and then click Remove.

8. Repeat step 7 for any other resource dependencies, and click Next.
9. Set resource properties in the Parameters dialog box,

Installation procedure

Step 1 - Install GFI MailEssentials in the shared hard drive on active
server

1. Logon on the active node of your IS cluster using administrator
credentials.

2. Double click mailessentials14.exe (32-bit install) or
mailessentials14_x64.exe (64-bit install) accordingly.

3. Select install language and click Next.

4. Select whether to check for newer versions/builds of GFlI
MailEssentials and click Next.

5. Read licensing agreement. To proceed with the installation select |
accept the license agreement and click Next.

6. Click Next to install in default location or click Browse to change
path.

7. Specify user details and enter license key. Click Next to continue.

8. Specify the email address where notifications (e.g. failed anti spam
filters, spam digests) are sent.
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]‘E GFI MailEssentials Setup M= E3
>

Active Directory

Arccess to Active Directon) users

Does this zerver have access to all the email users in Active Directany’?

o Tes, all email users are available on Active Directory, wles will be based on
Active Directon users.

Ma, | do not have Active Directary or my network, does not have access to
Active Directony [DME], riles will be bazed on SMTP email addreszes.

GFI MailE zzentials®

< Back Cancel

Screenshot 31 - Selecting SMTP mode or Active Directory mode

9. Specify whether GFI MailEssentials will get the list of email users
(required for user-based configuration/rules e.g. disclaimers) from
Active Directory or SMTP server. Click Next to continue.

fi# GFI MailEssentials Setup [ [
Microzoft Message Queuing Service }r {
M

The GFl MailE zzentials Lizt Server requires the Microzoft Meszage Queuing Service
[MSkE]. The Meszaging Queuing Service iz & scalable system service developed by
ticrozoft to enable high wolume event proceszing. Thiz service i included with eveny
Windows 2000, %P and 2003 verzionz, although not abways inztalled by default

The GFI MailE zzentialz installation can install MSMO for you, To complete thiz process,
wou will reguire the windows 2000, =P ar 2003 CD .

We recommend to inztall the MSMO at this point howeser pou can also install it at a later
stage. Fleaze note that you cannot uze the List Server without kS kGL

Do pou want toingtall the MSMO eervice now?

GFI MailE zzentials®

¢ Back Mewt = | Cancel

Screenshot 32 - Installing Microsoft Message Queuing Service

10. If Microsoft Message Queuing Services (MSMQ) is not installed
then the dialog in the above screenshot will open. To be able to use
list servers (i.e. distributions lists), select Yes to install MSMQ.
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i'é" GFI MailEzzentialz for ExchangefSMTP Setup !E[E

Confirm inbound email domains }1-‘ {:
i

Click Mest to begin installation.

The follawing inbound emall domains were found:

gfi.co.uk
gfi.com
gfimalta.conm
lozalhost

& GFl MailEzzentialz can only process emails addressed to the domaing
lizted above. Therefore, if SPAk email iz ent to a domain not lizted
above it will not be blocked.

To further configure the above domainz, open the GFI Mailk zzentialz
cohfiguration, nght click on the General node and select Properties

GFI MailE zzentials®

¢ Back | Mext » I Cancel

Screenshot 33 - Configure your inbound email domain

11. Setup will now display the list of inbound email domains detected.
Verify that all inbound email domains to be protected against spam
are listed. Take note of any changes required for post-installation and
click Next.

NOTE: You can modify the list of inbound email domains ONLY post-
install. For more information refer to the Confirm domains to defend
against spam section starting on page 55 in this manual.

12. Click Finish to finalize your installation. On completion, setup will:

e Ask you to restart the SMTP service. Failing to restart the SMTP
service will negatively affect anti spam filtering and email flow.

e Check whether Microsoft XML engine is installed. This is
automatically installed if not found on UK/US English OS. For
other OS languages, this has to be manually downloaded and
installed. Microsoft XML engine can be downloaded from:

http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e Prompt you to launch the Quick Start Guide. This is a set of
instructions that will guide you through the GFI MailEssentials
configuration settings required post-install/for first use.

Step 2 - Install GFI MailEssentials on a passive server

1. Logon on the passive node of your Microsoft Exchange cluster
using administrator credentials.

2. Double click mailessentials14.exe (32-bit install) or
mailessentials14_x64.exe (64-bit install) accordingly.

3. Select install language and click Next.

4. Select whether to check for newer versions/builds of GFlI
MailEssentials and click Next.
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5. Read licensing agreement. To proceed with the installation select |
accept the license agreement and click Next.

6. Click Next to install in default location or click Browse to change
path.

7. Specify user details and enter license key. Click Next to continue.

8. Specify the email address where notifications (e.g. failed anti spam
filters, spam digests) are sent.

]‘E GFI MailEssentials Setup M= E3
»

Active Directory

Access to Active Directony users

[Does thiz zerver have accezs to all the email uzers in Active Directony?

o ez, all email users are availabls on Active Directory, wles will be based on
Active Directon users.

Ma, | do not have Active Directary or my network, does not have access to
Active Directony [DME], riles will be bazed on SMTP email addreszes.

GFI MailE zzentials®

Cancel

< Back

Screenshot 34 - Selecting SMTP mode or Active Directory mode

9. Specify whether GFI MailEssentials will get the list of email users
(required for user-based configuration/rules e.g. disclaimers) from
Active Directory or SMTP server. Click Next to continue.

fi& GFI MailEssentials Setup =]

Microzoft Meszage Queuing Service

The GFI MailE zzentials Lizt Server requires the Microzoft Message Queuing Service
[MSHML]. The Meszaging Queuing Service iz a scalable system service developed by
bdicrozoft to enable high wolume event proceszing. Thiz zervice iz included with evemn
Windows 2000, %P and 2003 versions, although not abwaps installed by default.

The GFI MailE szentials inztallation can ingtall M5O for you, To complete this process,
wou will require the wWindows 2000, =P or 2003 CO

Wwe recommend to inztall the M5O at this point howeser pou can alzo install it at a later
stage. Fleaze nate that you cannot use the List Server without BMSHG.

Do pou want o install the MSMO service now?

GFI M ailE zzential=®

< Back Mest » | Cancel
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Screenshot 35 - Installing Microsoft Message Queuing Service

10. If Microsoft Message Queuing Services (MSMQ) is not installed
then the dialog in the above screenshot will open. To be able to use
list servers (i.e. distributions lists), select Yes to install MSMQ.

i GFI MailEssentials for Exchange/SMTP Setup !E[
Confirm inbound email domains <y + L
Click Mext to begin installation. ]14-1

The following inbound email domains were found:

gfi.co.uk
qgfi.cam
gfimalta.com
lozalhost

& GF| MailEzzentialz can only proceszs email: addrezzed to the domaing
listed abowve. Therefare, i SPAM email iz zent to a domain not listed
above it will not be blocked.

To further configure the above domainz, open the GFl Mailk szentialz
configuration, right click on the General node and select Properties

GFI b ailE zzential=®

< Back | Mext » I Cancel

Screenshot 36 - Configure your inbound email domain

11. Setup will now display the list of inbound email domains detected.
Verify that all inbound email domains to be protected against spam
are listed. Take note of any changes required for post-installation and
click Next.

NOTE: You can modify the list of inbound email domains ONLY post-
install. For more information refer to the Confirm domains to defend
against spam section starting on page in this manual.

12. Click Finish to finalize your installation. On completion, setup will:

e Ask you to restart the SMTP service. Failing to restart the SMTP
service will negatively affect anti spam filtering and email flow.

e Check whether Microsoft XML engine is installed. This is
automatically installed if not found on UK/US English OS. For
other OS languages, this has to be manually downloaded and
installed. Microsoft XML engine can be downloaded from:

http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e Prompt you to launch the Quick Start Guide. This is a set of
instructions that will guide you through the GFI MailEssentials
configuration settings required post-install/for first use.

Step 3 - Add specific GFl MailEssentials services to IIS Server cluster
resource group

When installing GFI MailEssentials in a clustered windows
environment, the product services described below are not
automatically included in a cluster resource group. Consequently, if
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the cluster node on which GFI MailEssentials is running fails, these
product services are not moved to another cluster node along with the
resource group and they will not be restarted on the new node. As a
result, GFI MailEssentials will not start up properly after a failover in a
cluster environment.

The services to be added to the Exchange Virtual Server cluster
resource group are:

Display Name: GFIl MailEssentials Legacy Attendant Service

e Dependencies: None

e Service Name: GFIl MailEssentials Legacy Attendant Service
e Start Parameters: None

e Registry Replication: None

Service Name: gfiasmlhost

Display name: GFI MailEssentials Managed Attendant Service
Dependencies: None

Start Parameters: None

Registry Replication: None

Service Name: listserv

Display Name: GFI MailEssentials List Server

Dependencies: GFI MailEssentials Legacy Attendant
Start Parameters: None

Registry Replication: None

Service Name: GFI POP2Exchange

e Display Name: GFI POP2Exchange

o Dependencies: GFl MailEssentials Legacy Attendant
e Start Parameters: None

e Registry Replication: None

Service Name: GFIMETRXSVC

o Display Name: GFl MailEssentials Enterprise Transfer Service
o Dependencies: GFl MailEssentials Legacy Attendant

e Start Parameters: None

¢ Registry Replication: None

To add these services:

1. Go to Control Panel » Administrative Tools Cluster
Administrator.

2. In the tree view on the left hand side of the ‘Cluster Administrator
console’, expand the cluster root node and then the Groups node.
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3. Right-click on the IIS Cluster group resource to bring up the pop-up
menu.

4. Scroll down to the New menu item to expand it, and select
Resource to bring up the New Resource wizard.

5. Enter the service display name in the ‘Name’ and ‘Description’
fields. Select ‘Generic Service’ as Resource Type and select the
Exchange Virtual Server cluster group resource as the group to which
the new resource will be added. Click Next.

6. In the Possible Owners dialog, add the nodes of the Exchange
cluster to the list of preferred owners. Click Next.

7. Select the resource dependencies in the Dependencies dialog.
Click Next.

8. In the ‘Generic Service Parameters’ dialog, enter the service name,
and leave the start parameters text box empty. Click Next.

9. Click Finish to finalize your configuration. Do not add any keys in
the ‘Registry Replication’ dialog.

10. Repeat from step 3 to 8 above for each service mentioned above.

11. Right-click on the newly added resource(s) and select Bring
Online to enable services. These resources are visible in the list of
cluster resources of the Exchange Virtual Server cluster.

3.7.3 Post-install actions

At this stage, GFI MailEssentials is installed. You must now configure
GFI MailEssentials for first use.

To ensure that your GFI MailEssentials anti spam system is effectively
up and running do as follows:

Step 1: Launch GFI MailEssentials Configuration console

Click on Start » All Programs » GFl MailEssentials » GFI
MailEssentials Configuration.

Step 2: Verify current DNS Server settings

1. Right click Anti spam node and select Properties.

2. Click on the DNS Server tab. Verify the DNS server details
automatically detected during install.

3. To specify a different DNS Server, select Use the following DNS
server and specify details.

4. Click Test to check your newly added DNS server settings.
5. Click OK to finalize your configuration.

Step 3: Confirm domains to defend against spam

NOTE: ONLY the inbound email domains configured in GFI
MailEssentials will be protected against spam.

1. Right click General node and select Properties.

2. Click on the Inbound Email Domains tab and ensure that all
required inbound domains are listed in the Inbound domains field.
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3. To specify additional domains, click Add... and enter inbound email
domain details.

4. Click OK button to finalize your configuration.

Step 4: Enable Directory Harvesting

This filter uses Active directory or LDAP lookups to verify whether
inbound emails are addressed to legitimate ‘internal’ email accounts.
To enable this filter:

1. Right click Anti spam node and select Directory Harvesting »
Properties.

2. Select Enable directory harvesting protection.
3. Select the lookups method to be used:

e Use native Active Directory lookups option — Select this option
if during installation you selected to get the list of email users from
Active Directory (see Installation Procedure section above — step
9).

e Use LDAP lookups — Select this option if during installation you
selected to get the list of email users from SMTP server using
LDAP (see Installation Procedure section above — step 9). In
addition:

0 Unselect the Anonymous bind option if your LDAP server
requires authentication

0 Enter the authentication details using Domain\User format.
Click Test button to test your LDAP configuration settings.

Step 5: Configure whitelists

This filter allows you to specify lists of ‘friendly’ email domains, email
addresses or |IP addresses.

WARNING: USE THIS FEATURE WITH CAUTION. Entries in this list
will not be scanned for spam and will bypass all anti spam filtering.

1. Right click Anti spam node and select Whitelist » Properties.
2. Click on the Whitelist tab.

3. Click Add... and specify domains/email addresses or IP addresses
to whitelist.

4. Click OK to finalize your configuration.

Step 6: Test your anti spam system

GFI MailEssentials is now ready to start managing spam. To verify
that anti spam is working properly:

1. Clicking Start » All Programs » GFl MailEssentials » GFI
MailEssentials Dashboard.

2. Using an external email account (for example webmail, hotmail or
Gmail), create a new email and key in “100% free” as the subject.

3. Send the email to one of your internal email accounts. GFI
MailEssentials will tag this email as spam by adding the tag [SPAM] to
the email ‘subject’ field.
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4. Allow some time for email delivery and confirm that email spam

tagging is working by:

[ GFI MailEssentials Dashboard

File  Options  Help

tatiztics I FZ2E Logging I

=l E3

— Status of key services
'ZC':J" GFl MailE ssentials Managed Attendant Service iz Running
I.@I GFI MailE szential: Legacy Attendant Service iz Running
I@ GFl MailE szentials Enterprize Transfer Agent iz Running

E@' GFI List Server iz Running
IQI GFI M ailE szential: POP2E2change Service is Running
.j@. 115 Admin Service iz Running

M TA Logging
Processed Time | Filter Lewvel | Sender | Recipients | Subject ;I
= 2/26/2009 3:00:24 P FullEmal  "John Doe" <johndoe@ hotmail. coms johindoe@domain. com 100%% Free
="

y

4 |

Screenshot 37 - Testing your anti spam system

e Checking the GFI MailEssentials Dashboard. Use the Status tab to
view the status of key GFI MailEssentials services and email
processing activity. Receipt and processing status of this email is
logged in the MTA logging window.

Inbox - Microsoft Outlook
i Hle Edt Actions  Help V]
iqiNew - | =§ (%3 X | CaReply ¥Replyto Al i< Forward | [FSend/Receive - | BpFind [ | (L [

View Go Tools

Favorite Folders Y [ @ From Subject |Received |Size kg

[[=] Inbox in Mailbox

L] Unread Mail in Mailbox
[ For Follow Up in Mailbax
[ Sent Items in Mailbox

All Mail Folders

=l Date: Today
John Doe

"~ [SPAM] + ttention - Read Carefully! Fri 27-02-09 2:03 PM

=] %5 Personal Folders &
(&) Deleted Items
LA Drafis @ ttention - Read Carefully!
H L] Inbox
[ @ Junk E-mail [g] & John Doe
L= Outbox
|5 Sent Items From: ADMINISTRATION [meilto:security@federalreservebank.us] ~
= [ search Foiders Sent: Tuesday, February 24, 2009 12:48 PM 1
"Lé For Follow Up [15] Subject: Attention - Read Carefully!
L3 Large Mail
[ Unread Mail
& 5§ Archive Folders

FEDERAL RESERVE BANK

= Important:
v
You're getting this letter in connection with new directions
|..'.‘d Hail issued by U.S5. Treasury Department. The directions concern U.S5.
Federal Wire and ACH online payments. =
g On February 17, 2009 a large-scaled phishing attack =sctarted and
=} Loviacts has been still lasting. A great number of banks and credit unions
= is affected by this attack and quantity of illegal bank transfers
Jd Tasl_s_ has reached an extremely high lewvel.
_-.J Notes U.5. Treasury Department, Federal Reserve, America Bankers
. IE \55 - Association (ABA) and Federal Deposit Insurance Corporation (FDIC) &
Ld od - =

1ltem

(17

Screenshot 38 — Email tagged as SPAM

e Accessing the inbox of the email account to which the test email
was sent and confirm that email subject includes [SPAM] in the
subject field.
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3.7.4 GFIl MailEssentials Configuration

At this stage, your GFl MailEssentials anti spam system is up and
running. All inbound email will be scanned by the anti spam filters
enabled by default (see Table 7 - Anti spam filters enabled by default

users is used to identify spam.

below).
Description Enabled by
Default
An anti spam engine that determines if an
SpamRazer email is spam by using email reputation, v
message fingerprinting and content
analysis.
Director Stops email which is randomly generated
Y towards a server, mostly addressed to non- v
Harvesting :
existent users.
Blocks emails that contain links in the
PURBL message bodies pomtmg Fo knoyvn _phlshlng v
sites or if they contain typical phishing
keywords.
SPF Stops email which is received from x
domains not authorized in SPF records
I Addresses that an email is sent to are
Auto-Whitelist automatically excluded from being blocked. v
Whitelists A custom list of safe email addresses v
Custom A custom list of blocked email users or v
blacklist domains.
Checks if the email received is from
DNS blacklists | senders that are listed on a public DNS v
blacklist of known spammers.
Stops emails which contain links to
SURBL domains listed on public Spam URI v
Blocklists such as sc.surbl.org
Header A module which analyses the individual
checkin fields in a header by referencing the SMTP v
9 and MIME fields
Keyword Spam messages are identified based on x
checking blocked keywords in the email title or body
Emails that have been received from
New Senders senders to whom emails have never been X
sent before.
Bavesian An anti spam technique where a statistical
yesl probability index based on training from X
analysis

v’ - Enabled by default

X - Not enabled by default
Table 7 - Anti spam filters enabled by default

By default, email classified as spam will be tagged (i.e. will include the
prefix [SPAM] in the subject field - see Screenshot 38 above).
Although enabled by default, email tagging is NOT the only anti spam
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filter action that can be triggered on detection of email spam (see
Table 8 - Anti spam filter actions below). Other actions include re-
routing of spam emails to specific folders and deletion of spam emails.

Anti spam filter actions

G @ D g e}

. s 38 =, ¢
Filters o % SE| 58 S

T = o o ..9 8 %

cs8| 20| o o

s qE; ¢ 5 3 o

AR

= =

SpamRazer v v v v v v
Directory Harvesting v 4 v 4 v v
PURBL v v v v v v
SPF 7 7 v v v v
Whitelists O O O O O O
Custom Blacklist v v 4 v v v
DNS blacklists v 4 v v v v
SURBL v v v v v v
Header Checking v v v v v v
Keyword Checking v v 4 v v v
New Senders v v v v X v
v v v v v v

Bayesian Analysis

v’ - Action supported
X - Action not possible

O - Not applicable
Table 8 - Anti spam filter actions

Configuration of anti spam filters and actions is possible via the GFI
MailEssentials Configuration console. Additionally, through this
console you can also run reports and customize other product
features such as enable daily spam digest.

For guidelines on how to configure GFl MailEssentials functions and
features refer to the GFI MailEssentials Administration and
Configuration manual.
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4 Installation for Microsoft Exchange
2007

4.1 Introduction

GFl MailEssentials installation depends on your network
infrastructure, i.e. Microsoft Exchange 2007 or SBS 2008 setup. You
can install this product on:

e Same server running Microsoft Exchange or SBS: This setup is
typically used to filter email spam on Microsoft Exchange or SBS
servers set to receive emails directly from ‘outside’ (i.e. the
internet).

e Mail gateway or relay/perimeter server: This type of installation
is commonly used to filter spam in distributed email infrastructures
— especially those running a DMZ. In this environment a dedicated
machine is set to relay emails to another server running Microsoft
Exchange. Here, GFI MailEssentials is typically installed on the
mail relay server so that email spam is filtered before reaching
your Microsoft Exchange server. This setup reduces network
traffic, email storage and processing requirements on your email
infrastructure.

e Microsoft Exchange Server 2007 clusters: This type of
installation is commonly used to filter spam within environments
where clusters are used as disaster prevention and recovery
mechanisms.

4.2 System requirements
4.21 Software

Supported operating systems

e Microsoft Windows Server 2008 x64

e Microsoft Windows Server 2008 x32 (Installations on
gateway/perimeter server only)

e Microsoft Small Business Server (SBS) 2008 Standard

Mail Servers
e Microsoft Exchange Server 2007 or Microsoft Exchange Server
2007 SP1 with the following roles:
o Edge Server role
0 Hub Transport role
0 Hub Transport role and Mailbox server role
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NOTE: Mailbox Server role alone is not supported.

Other components

e Microsoft .NET Framework 2.0

e Microsoft XML core services: This is required by the GFI
MailEssentials reporter to enable anti spam report generation. For
UK/US English OS this is installed automatically by GFI
MailEssentials. For other languages, this can be downloaded from:

http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e Microsoft Virtual Server cluster group resource with a physical disc
cluster. This is required ONLY for environments running Microsoft
Exchange 2000/2003 clusters. For more information refer to:

http://technet.microsoft.com/en-us/library/bb124318(EXCHG.65).aspx

e (OPTIONAL) Microsoft Message Queuing Services: This is
required ONLY if list servers are used. MSMQ is used by GFI
MailEssentials to ensure the reliable running of distributions lists
on list servers. For more information on list servers refer to ‘List
servers’ section in the Administration and Configuration manual.

4.2.2 System requirements: Hardware

Processor

e Minimum: Intel Pentium or compatible 1 GHz 32-bit processor

¢ Recommended: x64 architecture-based server with Intel 64
architecture or AMD64 platform

Memory

¢ Minimum: 1GB RAM
e Recommended: 2GB RAM

Physical Storage

e Minimum: 500MB for installation, 2GB for execution
¢ Recommended: 500MB for installation, 4GB for execution

4.3 Important settings

4.3.1 Antivirus and backup software

Antivirus and backup software may cause GF| MailEssentials to
malfunction. This occurs when such software denies access to certain
files required by GFI MailEssentials

Disable third party antivirus and backup software from scanning the
following folders:
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x86 installations (32-bit) X64 installations (64-bit)

<..\Program Files

<.\Program Files\GFI\MailEssentials> (x86)\GFI\MailEssentials>

<..\Program Files (x86)\Common

<..\Program Files\Common Files\GFI> Files\GEI>

<.\Inetpub\mailroot> If installed on a gateway machine.

<..\Program Files\Exchsrvr\Mailroot> If installed on the same machine as
Microsoft Exchange 2007.

4.3.2 Firewall port settings

Configure your firewall to allow the following port connections. These
ports are used by GFIl MailEssentials to connect to GFI servers:

e DNS (Port 53) - Used by anti spam filters (DNS blacklist, Sender
Policy Framework, Header Checking) to identify the domain from
where received emails originated.

e FTP (Ports 20 and 21) — Used by GFI MailEssentials to connect
to ‘ftp.gfisoftware.com' and retrieve latest product version
information.

e HTTP (Port 80) — Used by GFI MailEssentials to download
product patch and anti spam filter updates (i.e. SpamRazer, Anti-
Phishing, and Bayesian anti spam filters) from the following
locations:

o 'http://update.gfi.com’

o0 'http://update.gfisoftware.com’

o0 'http://support.gfi.com

o0 'http://db11.spamcatcher.net' (GFI MailEssentials 14 or
earlier)

o0 'http://sn92.mailshell.net' (GFI MailEssentials 14 SR1 or
later)

e Remoting (Ports 8021) - Used in the latest builds of GFI
MailEssentials for inter-process communication. No firewall
configuration is required to allow connections to or from the
remoting ports since all the GFI MailEssentials processes run on
the same server.

NOTE: Ensure that no other applications (except GFlI
MailEssentials) are listening on port 8021.

e (OPTIONAL) LDAP (Port 389) — Used by GFI MailEssentials to
get email addresses from SMTP server. ONLY required if the
server running GFI MailEssentials does not have access/cannot
get list of users from Active Directory e.g. in a DMZ environment or
other environment which does not use Active Directory.

4.4 Installing on Microsoft Exchange or SBS server

4.4.1 Upgrade from earlier version

If you are currently using a previous version of GFI MailEssentials
(version 12), you can upgrade your current installation while at the
same time retain all your existing configuration settings.
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Important notes

¢ Upgrades cannot be undone i.e. you cannot downgrade to an
earlier version once you have installed the latest version.

¢ On upgrading an existing installation, licensing reverts to trial
version and a new fully purchased license key for the GFl
MailEssentials 14 is required. For more information on new license
keys, refer to: http://customers.gfi.com

e You cannot change the installation path during GFI MailEssentials
upgrades.

Upgrade procedure

1. Launch GFI MailEssentials installation on the server where your
earlier version of GFI MailEssentials is installed.

GFI MailEssentials E

€ | GFIMaiEssentials version 12.0.2007.1203 is already installed. You must uninstall the existing version befare instaling GFI
__-/ MailEssentials version 12.0.2005.0324.

IMPORTAMT: The new build requires the Microsoft .MET Framework 2. 00installed on this machine.

Do wou wank to uninstall the exisking version of GFI MailEssentials?

Screenshot 39 - Confirm the upgrade

2. Click Yes to start the upgrade process and follow on-screen
instructions. For assistance refer to New installations section below.

4.4.2 New installations

Important notes

1. During installation, GFI MailEssentials restarts Microsoft Exchange
Server services. This is required to allow GFI MailEssentials
components to be registered and started.

2. Before starting installation, close any running Windows applications.

3. Since Microsoft Exchange Server 2007 can only be installed on
Windows Server 2008 64-bit, GFI MailEssentials 64-bit version is
required.

Installation procedure

1. Logon your Microsoft Exchange Server machine using administrator
credentials.

2. Double click mailessentials14_x64.exe.
3. Select install language and click Next.

4. Select whether to check for newer versions/builds of GFI
MailEssentials and click Next.

5. Read licensing agreement. To proceed with the installation select |
accept the license agreement and click Next.

6. Click Next to install in default location or click Browse to change
path.

7. Specify user details and enter license key. Click Next to continue.
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8. Specify the email address where notifications (e.g. failed anti spam
filters, spam digests) are sent.

]‘E GFI MailEssentials Setup M= E3
*

Active Directory

Access to Active Directary users

[loes thiz zerver have accezs to all the email uzers in Active Directom?

5 Tes, all email uzers are available on Active Directory, wiles will be bazed on
Active Directony users.

Ma, | do not have dctive Directory or my network, does not have access o
Active Directary [DME], mules will be based on SMTP email addreszses.

GF] MailEzzentialz®

Cancel

< Back

Screenshot 40 - Selecting SMTP mode or Active Directory mode

9. Specify whether GFI MailEssentials will get the list of email users
(required for user-based configuration/rules e.g. disclaimers) from
Active Directory or SMTP server. Click Next to continue.

fi# GFI MailEssentials Setup [ [=]

Microsoft Message Queuing Service

The GFI MallE zzentialz List Server requires the kMicrozoft Message Queuing Service
[M5BE]. The Meszaging Queuing Service iz a zcalable zpztem zervice developed by
icrozoft to enable high valume event pracessing. Thiz service iz included with even
Windows 2000, %P and 2003 verzions, although not abways installed by default.

The GFI MailE zzentials inztallation can inztall kSO for you To complete this process,
woul will reguire the wWindows 2000, P or 2003 CD .

Wie recommend to inztall the MSMO &t thiz point however vou can alsa install it at a later
ztage. Fleaze note that you cannot use the List Server without S0,

Do you want to install the MSMOA zervice now?

GFI b ailE zzential=E

{ Back Mest > | Cancel

Screenshot 41 - Installing Microsoft Message Queuing Service

10. If Microsoft Message Queuing Services (MSMQ) is not installed
then the dialog in the above screenshot will open. To be able to use
list servers (i.e. distributions lists), select Yes to install MSMQ.
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11. Click Finish to finalize your installation. On completion, setup will:
e Ask you to restart the SMTP service.

IMPORTANT: Failing to restart the SMTP service will
negatively affect anti spam filtering and email flow.

e Check whether Microsoft XML engine is installed. This is
automatically installed if not found on UK/US English OS. For
other OS languages, this has to be manually downloaded and
installed. Microsoft XML engine can be downloaded from:
http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e Prompt you to launch the Quick Start Guide. This is a set of
instructions that will guide you through the configuration settings
required post-install/for first use (Recommended).

e Launch the post-installation wizard that registers GFlI
MailEssentials with the local installation of Microsoft Exchange
2007.

Post-installation wizard

1. Click Next in the welcome page.

[l GFI MailEssentials Post-Installation Wizard o =] 5

Inbound email domains
Specify the email domaing GFI MailEszentialz should treat az inbound.

[Diomainz with an aztensk next to them form part of the accepted domain ligt in Exchange.
The inbound email domain: you add here, affect the GF| MailE zzentiale configuration
only. The Microzoft Exchange accepted domain list is not modified.

add

ienzebd local
' Femaove

< Back I Mesxt » I Cancel

Screenshot 42 — Inbound email domains list

2. In the accepted domain list:
¢ Review local domains found.

NOTE: Asterisks (*) next to inbound email domains indicate
domains detected by Microsoft Exchange.

e Key in inbound domain details in the Inbound email domains box
and click Add

e Select domains and clicking Remove to remove domains.
Click Next to continue setup.
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H GFI MailEssentials Post-Installation Wizard

Installaion Summany
The following GFl MailEszentialz components will be installed.

The wizard detected the following Exchange Server 2007 roles.

M ailbios
Hub Transpaork
Client Access

The following GFl MailEszentialz components will be installed.

Submitted Agent
Fouting Tranzport Agent
SMTF Trangzport Agent

Click Mext, to inztall

¢ Back

Cancel |

Screenshot 43 - Server roles detected and list of components to install.

3. A list of the Microsoft Exchange Server 2007 server roles detected
and GFI MailEssentials components required is displayed. Click Next
to install the required GFI MailEssentials components.

4. Click Finish to finalize the installation.

5. At this stage, GFI MailEssentials is installed. You must now
configure GFI MailEssentials for first use. For instructions refer to the
next section titled Post-install actions.

4.4.3 Post-install actions

To ensure that your GFl MailEssentials anti spam system is effectively
up and running you must perform the following post-install actions:

Step 1: Launch GFI MailEssentials Configuration console

Click on Start » All Programs » GFl MailEssentials » GFI
MailEssentials Configuration.

Step 2: Verify current DNS Server settings

1. Right click Anti spam node and select Properties.

2. Click on the DNS Server tab. Verify the DNS server details
automatically detected during install.

3. To specify a different DNS Server, select Use the following DNS
server and specify details.

4. Click Test to check your newly added DNS server settings.
5. Click OK to finalize your configuration.
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Step 3: Confirm domains to defend against spam

NOTE: ONLY the inbound email domains configured in GFI
MailEssentials will be protected against spam.

1. Right click General node and select Properties.

2. Click on the Inbound Email Domains tab and ensure that all
required inbound domains are listed in the Inbound domains field.

3. To specify additional domains, click Add... and enter inbound email
domain details.

4. Click OK button to finalize your configuration.

Step 4: Enable Directory Harvesting

This filter uses Active directory or LDAP lookups to verify whether
inbound emails are addressed to legitimate ‘internal’ email accounts.
To enable this filter:

1. Right click Anti spam node and select Directory Harvesting »
Properties.

2. Select Enable directory harvesting protection.
3. Select the lookups method to be used:

o Use native Active Directory lookups option — Select this option
if during installation you selected to get the list of email users from
Active Directory (see Installation Procedure section above — step
9).

e Use LDAP lookups — Select this option if during installation you
selected to get the list of email users from SMTP server using

LDAP (see Installation Procedure section above — step 9). In
addition:

0 Unselect the Anonymous bind option if your LDAP server
requires authentication.

Enter the authentication details using Domain\User format.
o Click Test button to test your LDAP configuration settings.

Step 5: Configure whitelists
This filter allows you to specify lists of ‘friendly’ email domains, email
addresses or |IP addresses.

WARNING: USE THIS FEATURE WITH CAUTION. Entries in this list
will not be scanned for spam and will bypass all anti spam filtering.

1. Right click Anti spam node and select Whitelist » Properties.
2. Click on the Whitelist tab.

3. Click Add... and specify domains/email addresses or IP addresses
to whitelist.

4. Click OK to finalize your configuration.

Step 6: Test your anti spam system

GFI MailEssentials is now ready to start managing spam. To verify
that anti spam is working properly:
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1. Clicking Start » All Programs » GFl MailEssentials » GFI

MailEssentials Dashboard.

2. Using an external email account (for example webmail, hotmail or
Gmail), create a new email and key in “100% free” as the subject.

3. Send the email to one of your internal email accounts. GFI
MailEssentials will tag this email as spam by adding the tag [SPAM] to

the email ‘subject’ field.

4. Allow some time for email delivery and confirm that email spam

tagging is working by:

[ GFI MailEssentials Dashboard
Eile

Options  Help

| Statisticsl FZE Loggingl

=l E3

— Statuz of key services
C:’J GFl MailE ssentials Managed Attendant Service iz Running
(‘,’J GFI MailE szential: Legacy Attendant Service iz Running
C" GFl MailE szentials Enterprize Transfer Agent iz Running

WF GFI List Server is Bunning
-6- GFI M ailE szential: POP2E2change Service is Running
(‘_) 115 Admin Service iz Running

M TA Logging
Processed Time I Filter Lewvel I Sender | Recipients | Subject AI
=4 242642009 3:00:24 PM Full Emal  “Jahn Dos" <johndoe® hotmail coms johindoe@domain. com 100%% Free
="
« | _>J_|

Screenshot 44 - Testing your anti spam system

Checking the GFI MailEssentials Dashboard. Use the Status tab to
view the status of key GFI MailEssentials services and email
processing activity. Receipt and processing status of this email is
logged in the MTA logging window.
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I8l Inbox - Microsoft Outlook

! Fle Edt WView Go Took Actions Help pe a question for help |+

PoadnNew x| BY X | i~ Reply -4 Reply to All .5 Forward | ngend;’Re;ewe = ‘i_‘;Fl,nd | [

Favorite Folders Y [ @ From Subject Received Size w

=] Inbox in Mailbox
L3 Unread Mail in Mailbox =) Date: Today
L For Follow Up in Mailbox
[ sent Items in Maibox

[SPAM] s ttention - Read Carefully! Fri 27-02-09 2:03 PM

All Mail Folders

= £5¥ Personal Folders

(&) Deleted Ttems
L2\ Drafts @ ttention - Read Carefully!
H ] Inbox B Doc

[ g Junk E-mail [£]

L[5 Outbox
L5 Sent Items From: ADMINISTRATION [mailto:security@federalreservebank.us] ~
= [ Search Folders Sent: Tuesday, February 24, 2009 12:48 PM
L) For Follow Up [15] Subject: Attention - Read Carefully!
L3 Large Mail
L) unread Mail
4 3 Archive Folders FEDERAL RESERVE BANK
Imporcant:
v
. You're getting this letter in connection with new directions
_ZJ Hail issued by U.5. Treasury Department. The directions concern U.S.
jﬁ - Federal Wire and ACH online payments.
. lendar
g On February 17, 2009 a large-scaled phishing attack started and
=L Cogtacts has been still lasting. A great number of banks and credit unions
= is affected by this attack and quantity of illegal bank transfers
/] Tasks has reached an extremely high level.
.| motes E ; . 3 e
U.5. Treasury Department, Federal Reserve, America Bankers
IE‘ 53 » Association (ABA) and Federal Deposit Insurance Corporation (FDIC) a
Ld 6 Bed
1Item L

Screenshot 45 — Email tagged as SPAM

e Accessing the inbox of the email account to which the test email
was sent and confirm that email subject includes [SPAM] in the
subject field.

4.4.4 GFIl MailEssentials Configuration

At this stage, your GFIl MailEssentials anti spam system is up and
running. All inbound email will be scanned by the anti spam filters
enabled by default (see Table 9 - Anti spam filters enabled by default

below).
e Enabled by
Description Default

An anti spam engine that determines if an

SpamRazer email is spam by using email reputation, v
message fingerprinting and content
analysis.

Directo Stops email which is randomly generated

ry towards a server, mostly addressed to non- v

Harvesting .
existent users.
Blocks emails which contain links in the

PURBL message bodies p0|_nt|ng _to kn0\_/vn _phlshmg v
sites or if they contain typical phishing
keywords.

SPF Stops email which is received from x
domains not authorized in SPF records

Auto-Whitelist Addresses that an email is sent to are v

automatically excluded from being blocked.
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Whitelists A custom list of safe email addresses v

Custom A custom list of blocked email users or v
blacklist domains.

Checks if the email received is from
DNS blacklists | senders that are listed on a public DNS v
blacklist of known spammers.

Stops emails which contain links to
SURBL domains listed on public Spam URI v
Blocklists such as sc.surbl.org

A module which analyses the individual

cHr?:c?keirrw fields in a header by referencing the SMTP v
9 and MIME fields

Keyword Spam messages are identified based on x

checking blocked keywords in the email title or body

Emails that have been received from
New Senders senders to whom emails have never been X
sent before.

An anti spam technique where a statistical
probability index based on training from X
users is used to identify spam.

Bayesian
analysis

v’ - Enabled by default

X - Not enabled by default
Table 9 - Anti spam filters enabled by default

By default, email classified as spam will be tagged (i.e. will include the
prefix [SPAM] in the subject field - see Screenshot 45 above).
Although enabled by default, email tagging is NOT the only anti spam
filter action that can be triggered on detection of email spam (see
Table 10 - Anti spam filter actions below). Other actions include re-
routing of spam emails to specific folders and deletion of spam emails.

Anti spam filter actions

email address
Move to subfolder in
user mailbox
folder

Forward to specific
Move to junk mail

SN \ove to specific folder

SpamRazer v v v v v
Directory Harvesting v v 4 4 v
PURBL v v v v v
SPF v v v v v
Whitelists O O O O O
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Custom Blacklist
DNS blacklists
SURBL

Header Checking

ANEER N N NN

Keyword Checking

AN N N N A N N

New Senders X

SN N N N N N
DI N N N N N
AN N N N VS
AN N NN Y N

Bayesian Analysis v v

v' - Action supported
X - Action not possible

O - Not applicable
Table 10 - Anti spam filter actions

Configuration of anti spam filters and actions is possible via the GFI
MailEssentials Configuration console. Additionally, through this
console you can also run reports and customize other product
features such as enable daily spam digest.

For guidelines on how to configure GFI MailEssentials functions and
features refer to the GFI MailEssentials Administration and
Configuration manual.

4.5 Installing on an email gateway or relay/perimeter server

Introduction

GFI MailEssentials can be installed:

e On a perimeter server (e.g. DMZ) with Microsoft Exchange Server
2007 in Edge Server role.

e As a mail relay server between the perimeter (gateway) SMTP
server and the recipients’ inboxes with Microsoft Exchange Server
2007 in Hub Transport role.

Both setups enable you to reduce unnecessary email traffic by using
your Active Directory resources (at a perimeter/gateway server level)
to drop connections of non-existent email recipients in incoming email.
This greatly helps against common spamming techniques such as
Directory Harvest Attacks (a brute force type of attack used by
spammers to find valid/existent e-mail addresses at a domain). This
structure eliminates most spam from arriving at your Microsoft
Exchange server.
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Perimeter (Gateway)
SMTP Server

Firewall

Mail Server +
GFI MailEssentials Internet

Figure 2 - A typical Perimeter SMTP Relay Server setup

4.5.1 Pre-install actions

Step 1: Send and Receive connector setup

NOTE: These connectors are not required for Microsoft Exchange
Server 2007 installed with Edge Server Role.

Ensure that the required Send connectors and Receive connectors to
and from Microsoft Exchange 2007 are created for servers installed
with Hub Transport Role.

Where these are not yet created:

1. Add a ‘Send Connector’ to Microsoft Exchange 2007 server to
forward all emails to the GFI MailEssentials machine

e From the Microsoft Exchange Server 2007 Management Console
select Organization Configuration » Hub Transport » Actions »
New Send Connector

e In the New SMTP connector wizard, key in the name for the
connector in the introduction screen.

NOTE: You can use ‘GFl MailEssentials SMTP Connector’.

e From the Select the intended use for this Send Connector drop
down list box select Internet.

e From the Address space screen click Add and key in *. Click Ok
> Next.

e Choose Route mail through the following smart host, click Add
and provide the IP address of the server where GFlI
MailEssentials is installed. Click Next to continue.

o Set the authentication for the GFI MailEssentials machine (if
required) and click Next.
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e Select the Hub Transport server with which the connector will be
associated and click Next.

o Verify the configuration Summary created. Complete the wizard to
create new send connector.

NOTE: On completion, the GFI MailEssentials connector will be
available in the Send Connectors tab and should be set to Enabled
by default.

2. Add a ‘Receive Connector’ to Microsoft Exchange 2007 server
to accept emails from the GFl MailEssentials Machine

e From the Exchange Management Shell and key in the following
command (Change the RemotelPRanges property with the IP
address for the GFI MailEssentials machine.) :

new-receiveconnector -name "GFI
MailEssentials" -Bindings "0.0.0.0:25" -
RemoteIPRanges "MailEssentials IP Address" -
AuthMechanism "ExternalAuthoritative™ -
PermissionGroups "ExchangeServers"
Example:

new-receiveconnector -name "GFI
MailEssentials" -Bindings "0.0.0.0:25" -
RemoteIPRanges "192.168.0.1" -AuthMechanism
"ExternalAuthoritative" -PermissionGroups
"ExchangeServers"

Step 2: Test your new mail relay server

Before installing GFI MailEssentials, verify that your new mail relay
server is working correctly:

Test IIS SMTP inbound connection via test email

1. Send an email from an ‘external’ account (e.g. internet email
account) to an internal email address/user.

2. Ensure that intended recipient received the test email in the
respective email client.

Test IIS SMTP outbound connection via test email

1. Send an email from an ‘internal’ email account to an external
account (e.g. internet email)

2. Ensure that the intended recipient/external user received the test
email.

NOTE: You can also use ‘Telnet’ to manually send the test email and
obtained more troubleshooting information. For more information refer
to:

http://support.microsoft.com/support/kb/articles/Q153/1/19.asp

4.5.2 Upgrades from earlier version

If you are currently using a previous version of GFI MailEssentials
(versions 9, 10, 11 and 12), you can upgrade your current installation
while at the same time retain all your existing configuration settings.

Important notes

e Upgrades cannot be undone i.e. you cannot downgrade to an
earlier version once you have installed the latest version.
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e On upgrading an existing installation, licensing reverts to trial
version and a new fully purchased license key for the GFI
MailEssentials 14 is required. For more information on new license
keys, refer to: http://customers.gfi.com

e You cannot change the installation path during GFI MailEssentials
upgrades.

e When upgrading from GFI MailEssentials 9, the current Bayesian
weights file will be upgraded to the new format used in GFI
MailEssentials 10 or later. The new format is more compact and
uses less memory. NO DATA WILL BE LOST.

4.5.3 Upgrade procedure

1. Launch GFI MailEssentials installation on the server where your
earlier version of GFI MailEssentials is installed.

GFI MailEssentials E

GFI MailEssentials version 12.0.2007.1203 is already installed. You must uninstall the existing version before instaling GFI
__-/ MailEssentials version 12.0.2005.0324.

IMPORTAMT: The new build requires the Microsoft .MET Framework 2. 00installed on this machine.

Do wou wank to uninstall the exisking version of GFI MailEssentials?

Screenshot 46 - Confirm the upgrade

2. Click Yes to start the upgrade process and follow on-screen
instructions. For assistance refer to New installations section below.

4.5.4 New installations

Important notes

1. During installation, GFI MailEssentials restarts Microsoft Exchange
Server services. This is required to allow GFI MailEssentials
components to be registered and started.

2. Before starting installation, close any running Windows applications.

Installation procedure

1. Logon your Microsoft Exchange Server machine using administrator
credentials.

2. Double click mailessentials14.exe (32-bit install) or
mailessentials14_x64.exe (64-bit install) accordingly.

3. Select install language and click Next.

4. Select whether to check for newer versions/builds of GFlI
MailEssentials and click Next.

5. Read licensing agreement. To proceed with the installation select |
accept the license agreement and click Next.

6. Click Next to install in default location or click Browse to change
path.

7. Specify user details and enter license key. Click Next to continue.

8. Specify the email address where notifications (e.g. failed anti spam
filters, spam digests) are sent.
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]‘E GFI MailEssentials Setup M= E3
>

Active Directory

Arccess to Active Directon) users

Does this zerver have access to all the email users in Active Directany’?

o Tes, all email users are available on Active Directory, wles will be based on
Active Directon users.

Ma, | do not have Active Directary or my network, does not have access to
Active Directony [DME], riles will be bazed on SMTP email addreszes.

GFI MailE zzentials®

< Back Cancel

Screenshot 47 - Selecting SMTP mode or Active Directory mode

9. Specify whether GFI MailEssentials will get the list of email users
(required for user-based configuration/rules e.g. disclaimers) from
Active Directory or SMTP server. Click Next to continue.

fi# GFI MailEssentials Setup [ [
Microzoft Message Queuing Service }r {
M

The GFl MailE zzentials Lizt Server requires the Microzoft Meszage Queuing Service
[MSkE]. The Meszaging Queuing Service iz & scalable system service developed by
ticrozoft to enable high wolume event proceszing. Thiz service i included with eveny
Windows 2000, %P and 2003 verzionz, although not abways inztalled by default

The GFI MailE zzentialz installation can install MSMO for you, To complete thiz process,
wou will reguire the windows 2000, =P ar 2003 CD .

We recommend to inztall the MSMO at this point howeser pou can also install it at a later
stage. Fleaze note that you cannot uze the List Server without kS kGL

Do pou want toingtall the MSMO eervice now?

GFI MailE zzentials®

¢ Back Mewt = | Cancel

Screenshot 48 - Installing Microsoft Message Queuing Service

10. If Microsoft Message Queuing Services (MSMQ) is not installed
then the dialog in the above screenshot will open. To be able to use
list servers (i.e. distributions lists), select Yes to install MSMQ.

11. Click Finish to finalize your installation. On completion, setup will:
e Ask you to restart the SMTP service.
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IMPORTANT: Failing to restart the SMTP service will
negatively affect anti spam filtering and email flow.

e Check whether Microsoft XML engine is installed. This is
automatically installed if not found on UK/US English OS. For
other OS languages, this has to be manually downloaded and
installed. Microsoft XML engine can be downloaded from:

http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e Prompt you to launch the Quick Start Guide. This is a set of
instructions that will guide you through the configuration settings
required post-install/for first use (Recommended).

e Launch the post-installation wizard that registers GFlI
MailEssentials with the local installation of Microsoft Exchange
2007.

Post-installation wizard

1. Click Next in the welcome page.

[l GFI MailEssentials Post-Installation Wizard o ] 4

Inbound email domains
Specify the email domaing GFI MailEszentialz should treat az inbound.

Diomainz with an azterzk next to them form part of the accepted domain lizt in Exchange.
The inbound email domain: you add here, affect the GF| MailE zzentiale configuration
only. The Microzoft Exchange accepted domain list is not modified.

Add

1enzabd local
' Hemaove

¢ Back I et > I Cancel

Screenshot 49 — Inbound email domains list

2. In the accepted domain list:
e Review local domains found.

NOTE: Asterisks (*) next to inbound email domains indicate
domains detected by Microsoft Exchange.

e Key in inbound domain details in the Inbound email domains box
and click Add.

e Select domains and clicking Remove to remove domains.
Click Next to continue setup.
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H GFI MailEssentials Post-Installation Wizard

Installaion Summany
The following GFl MailEszentialz components will be installed.

The wizard detected the following Exchange Server 2007 roles.

M ailbios
Hub Transpaork
Client Access

The following GFl MailEszentialz components will be installed.

Submitted Agent
Fouting Tranzport Agent
SMTF Trangzport Agent

Click Mext, to inztall

¢ Back

Cancel |

Screenshot 50 - Server roles detected and list of components to install.

3. A list of the Microsoft Exchange Server 2007 server roles detected
and GFI MailEssentials components required is displayed. Click Next
to install the required GFI MailEssentials components.

4. Click Finish to finalize the installation.

5. At this stage, GFI MailEssentials is installed. You must now
configure GFI MailEssentials for first use. For instructions refer to the
next section titled Post-install actions.

4.5.5 Post-install actions

To ensure that your GFl MailEssentials anti spam system is effectively
up and running you must perform the following post-install actions:

Step 1: Launch GFI MailEssentials Configuration console

Click on Start » All Programs » GFl MailEssentials » GFI
MailEssentials Configuration.
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Step 2: Verify current DNS Server settings

1. Right click Anti spam node and select Properties.

2. Click on the DNS Server tab. Verify the DNS server details
automatically detected during install.

3. To specify a different DNS Server, select Use the following DNS
server and specify details.

4. Click Test to check your newly added DNS server settings.
5. Click OK to finalize your configuration.

Step 3: Confirm domains to defend against spam

NOTE: ONLY the inbound email domains configured in GFI
MailEssentials will be protected against spam.

1. Right click General node and select Properties.

2. Click on the Inbound Email Domains tab and ensure that all
required inbound domains are listed in the Inbound domains field.

3. To specify additional domains, click Add... and enter inbound email
domain details.

4. Click OK button to finalize your configuration.

Step 4: Enable Directory Harvesting

This filter uses Active directory or LDAP lookups to verify whether
inbound emails are addressed to legitimate ‘internal’ email accounts.
To enable this filter:

1. Right click Anti spam node and select Directory Harvesting »
Properties.

2. Select Enable directory harvesting protection.
3. Select the lookups method to be used:

e Use native Active Directory lookups option — Select this option
if during installation you selected to get the list of email users from
Active Directory (see Installation Procedure section above — step
9).

e Use LDAP lookups — Select this option if during installation you
selected to get the list of email users from SMTP server using

LDAP (see Installation Procedure section above — step 9). In
addition:

0 Unselect the Anonymous bind option if your LDAP server
requires authentication.

0 Enter the authentication details using Domain\User format.
Click Test button to test your LDAP configuration settings.

Step 5: Configure whitelists
This filter allows you to specify lists of ‘friendly’ email domains, email
addresses or |IP addresses.

WARNING: USE THIS FEATURE WITH CAUTION. Entries in this list
will not be scanned for spam and will bypass all anti spam filtering.

1. Right click Anti spam node and select Whitelist » Properties.
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2. Click on the Whitelist tab.

3. Click Add... and specify domains/email addresses or |IP addresses

to whitelist.

4. Click OK to finalize your configuration.

Step 6: Test your anti spam system

GFI MailEssentials is now ready to start managing spam. To verify

that anti spam is working properly:

1. Clicking Start » All Programs » GFIl MailEssentials » GFlI

MailEssentials Dashboard.

2. Using an external email account (for example webmail, hotmail or
Gmail), create a new email and key in “100% free” as the subject.

3. Send the email to one of your internal email accounts. GFI
MailEssentials will tag this email as spam by adding the tag [SPAM] to

the email ‘subject’ field.

4. Allow some time for email delivery and confirm that email spam

tagging is working by:

5] GFI MailEssentials Dashboard
File  Options Help

| Statisticsl FZE Loggingl

— Status of key services
C:'J GFl MailE szentials M anaged Attendant Service iz Running
ﬂ GFl MailE szential: Legacy Attendant Service iz Running
G' GFI b ailE zzentialz Enterprize Transfer Agent iz Running

() GFI List Server iz Running
b GFl MailE szential: POP2Exchange Service is Running
Q'_} 115 Admin Service iz Bunning

M Ta Logging
Froceszed Time I Filter Lewel I Sender | Recipients | Subject AI
4 242642009 200:24 PM Full Email “John Doe <johndoe® hotmail coms johndoe@domain. com 1005z Free
= |
4 | il

Screenshot 51 - Testing your anti spam system

e Checking the GFI MailEssentials Dashboard. Use the Status tab
to view the status of key GFI MailEssentials services and email
processing activity. Receipt and processing status of this email is
logged in the MTA logging window.
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(&) Deleted Ttems
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H ] Inbox B Doc

[ g Junk E-mail [£]

L[5 Outbox
L5 Sent Items From: ADMINISTRATION [mailto:security@federalreservebank.us] ~
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L3 Large Mail
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4 3 Archive Folders FEDERAL RESERVE BANK
Imporcant:
v
. You're getting this letter in connection with new directions
_ZJ Hail issued by U.5. Treasury Department. The directions concern U.S.
jﬁ - Federal Wire and ACH online payments.
. lendar
g On February 17, 2009 a large-scaled phishing attack started and
=L Cogtacts has been still lasting. A great number of banks and credit unions
= is affected by this attack and quantity of illegal bank transfers
/] Tasks has reached an extremely high level.
.| motes E ; . 3 e
U.5. Treasury Department, Federal Reserve, America Bankers
IE‘ 53 » Association (ABA) and Federal Deposit Insurance Corporation (FDIC) a
Ld 6 Bed
1Item L

Screenshot 52 — Email tagged as SPAM

e Accessing the inbox of the email account to which the test email
was sent and confirm that email subject includes [SPAM] in the
subject field.

4.5.6 GFI MailEssentials Configuration

At this stage, your GFIl MailEssentials anti spam system is up and
running. All inbound email will be scanned by the anti spam filters
enabled by default (see Table 11 - Anti spam filters enabled by default

below).
e Enabled by
Description Default

An anti spam engine that determines if an

SpamRazer email is spam by using email reputation, v
message fingerprinting and content
analysis.

Directo Stops email which is randomly generated

H ry towards a server, mostly addressed to non- v

arvesting :

existent users.
Blocks emails that contain links in the

PURBL message bodies p0|_nt|ng _to kn0\_/vn _phlshmg v
sites or if they contain typical phishing
keywords.

SPF Stops email which is received from x
domains not authorized in SPF records

Auto-Whitelist Addresses that an email is sent to are v

automatically excluded from being blocked.
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Whitelists

Custom
blacklist

DNS blacklists

SURBL

Header
checking

Keyword
checking

New Senders

Bayesian
analysis

A custom list of safe email addresses

A custom list of blocked email users or
domains.

Checks if the email received is from
senders that are listed on a public DNS
blacklist of known spammers.

Stops emails which contain links to
domains listed on public Spam URI
Blocklists such as sc.surbl.org

A module which analyses the individual
fields in a header by referencing the SMTP
and MIME fields

Spam messages are identified based on
blocked keywords in the email title or body

Emails that have been received from
senders to whom emails have never been
sent before.

An anti spam technique where a statistical
probability index based on training from
users is used to identify spam.

X

v’ - Enabled by default
X - Not enabled by default

Table 11 - Anti spam filters enabled by default

By default, email classified as spam will be tagged (i.e. will include the
prefix [SPAM] in the subject field - see Screenshot 52 above).
Although enabled by default, email tagging is NOT the only anti spam
filter action that can be triggered on detection of email spam (see
Table 12 - Anti spam filter actions below). Other actions include re-
routing of spam emails to specific folders and deletion of spam emails.

SpamRazer

Directory Harvesting

PURBL

SPF

Whitelists

Anti spam filter actions

Forward to specific
email address
Move to subfolder in
user mailbox

O X N [|X X
O X N N N
O XN N [X X
O X XN |X X

Move to junk mail
folder

SN \ove to specific folder

O X N N s

82 o 3BInstallation for Microsoft Exchange 2007

Getting Started Guide



Custom Blacklist
DNS blacklists
SURBL

Header Checking

ANEER N N NN

Keyword Checking

AN N N N A N N

New Senders X

SN N N N N N
DI N N N N N
AN N N N VS
AN N NN Y N

Bayesian Analysis v v

v' - Action supported
X - Action not possible

O - Not applicable
Table 12 - Anti spam filter actions

Configuration of anti spam filters and actions is possible via the GFI
MailEssentials Configuration console. Additionally, through this
console you can also run reports and customize other product
features such as enable daily spam digest.

For guidelines on how to configure GFI MailEssentials functions and
features refer to the GFI MailEssentials Administration and
Configuration manual.

4.6 Installing on Microsoft Exchange Server 2007 clusters

On Microsoft Exchange 2007 servers only servers with the Mailbox
Role can be part of a cluster. Any other roles are required to be
installed on separate servers.

To install GFI MailEssentials as part of a Microsoft Exchange 2007
cluster, install GFI MailEssentials on a server running the Hub
Transport or the Edge Transport Role. Alternatively, you install GFlI
MailEssentials on a separate machine in gateway/perimeter server
mode.

e On Microsoft Exchange 2007 server clusters without the Mailbox
role, the option to move SPAM to subfolders of the users’ mailbox
is disabled.

e High availability for the Hub Transport, Edge Transport, Client
Access, and Unified Messaging server roles is achieved through a
combination of server redundancy, Network Load Balancing
(NLB), hardware load balancing, Domain Name System (DNS)
round robin, as well as proactive server, service, and infrastructure
management. In this case GFI MailEssentials will need to be
installed on all servers running the Hub Transport roles or all
servers running the Edge Transport roles.

Instructions on how to install GFI MailEssentials are provided in the
previous sections.
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5 Installation for Lotus Domino

5.1 Introduction

Installing GFI MailEssentials with Lotus Domino enables you to scan
all inbound emails received from ‘outside’ (i.e. the internet) for spam
before reaching your Lotus Domino server. Outbound emails relayed
to GFI MailEssentials are also processed (e.g. adding of disclaimers
and auto-whitelisting) before these are sent via internet.

To install GFI MailEssentials with Lotus Domino, the server where GFI
MailEssentials is installed must be configured as an email gateway
server (also known as "Smart host" or "Mail relay" server) for all your
email. All inbound and outbound email must pass through this server
for scanning before being relayed to the mail server for distribution.

5.2 System requirements
5.2.1 Software

Supported operating systems

Microsoft Windows Server 2008 (x86 or x64)

Microsoft Windows Server 2003 Standard/Enterprise (x86 or x64)
Microsoft Windows 2000 Server/Advanced Server (SP1 or higher)
Microsoft Small Business Server 2000 (SP2) / 2003 (SP1)

Mail Servers

e Lotus Domino 6 or later

Other components

e Microsoft .NET Framework 2.0

e Microsoft Data Access Components (MDAC) 2.8 - This
component is used by GFI MailEssentials’ mail archiving feature to
communicate with databases. Download this component from:

http://www.microsoft.com/Downloads/details.aspx?familyid=6C050
FE3-C795-4B7D-B037-185D0506396C&displaylang=en

e Internet Information Services (lIS) (x32 or x64) — SMTP service
and WWW service. This is required to enable communications
between GFI MailEssentials and Lotus Domino.

e Microsoft XML core services: This is required by the GFI
MailEssentials reporter to enable anti spam report generation. For
UK/US English OS this is installed automatically by GFI
MailEssentials. For other languages, this can be downloaded from:
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e (OPTIONAL) Microsoft Message Queuing Services: This is
required ONLY if list servers are used. MSMQ is used by GFI
MailEssentials to ensure the reliable running of distributions lists
on list servers. For more information on list servers refer to ‘List
servers’ section in the Administration and Configuration manual.

5.2.2 System requirements: Hardware

Processor

e Minimum: Intel Pentium or compatible 1 GHz 32-bit processor

¢ Recommended: x64 architecture-based server with Intel 64
architecture or AMD64 platform.

Memory

e Minimum: 1GB

¢ Recommended: 2GB RAM
Physical Storage

e Minimum: 500MB for installation, 2GB for execution.
¢ Recommended: 500MB for installation, 4GB for execution

5.3 Important settings

5.3.1 Antivirus and backup software

Antivirus and backup software may cause GFlI MailEssentials to
malfunction. This occurs when such software denies access to certain
files required by GFI MailEssentials.

Disable third party antivirus and backup software from scanning the
following folders:

x86 installations (32-bit) X64 installations (64-bit)

<..\Program Files

<..\Program Files\GFI\MailEssentials> (x86)\GFI\MailEssentials>

<..\Program Files (x86)\Common

<..\Program Files\Common Files\GFI> Files\GEI>

<.\Inetpub\mailroot> If installed on a gateway machine.

5.3.2 Firewall port settings

Configure your firewall to allow the following port connections. These
ports are used by GFIl MailEssentials to connect to GFI servers:

e DNS (Port 53) - Used by anti spam filters (DNS blacklist, Sender
Policy Framework, Header Checking) to identify the domain from
where received emails originated.
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e FTP (Ports 20 and 21) — Used by GFI MailEssentials to connect
to ‘'ftp.dfisoftware.com' and retrieve latest product version
information.

e HTTP (Port 80) — Used by GFI MailEssentials to download
product patch and anti spam filter updates (i.e. SpamRazer, Anti-
Phishing, and Bayesian anti spam filters) from the following
locations:

o 'http://update.gfi.com’

o0 'http://update.gfisoftware.com’

o0 'http://support.gfi.com

o0 'http://db11.spamcatcher.net' (GFI MailEssentials 14 or
earlier)

0 ‘http://sn92.mailshell.net' (GFI MailEssentials 14 SR1 or
later)

e Remoting (Ports 8021) - Used in the latest builds of GFI
MailEssentials for inter-process communication. No firewall
configuration is required to allow connections to or from the
remoting ports since all the GFI MailEssentials processes run on
the same server.

NOTE: Ensure that no other applications (except GFlI
MailEssentials) are listening on port 8021.

e (LDAP (Port 389) — Used by GFI MailEssentials to get email
addresses from Lotus Domino server.

5.4 Installing on gateway servers for Lotus Domino

5.4.1 Pre-install actions

GFI MailEssentials uses the IS SMTP service as its SMTP Server
and therefore the IIS SMTP service must be configured to act as a
mail relay server. This is achieved as follows:

Step 1: Enable IIS SMTP Service

1. Go to Start » Control Panel » Add or Remove Programs »
Add/Remove Windows Components.

2. Select Internet Information Services (lIS) and click Details.

3. Select the SMTP Service option and click OK.

4. Click Next to finalize your configuration.

Step 2: Create SMTP domain(s) for email relaying

1. Go to Start » Control Panel » Administrative Tools.
2. Click on Internet Information Services (lIS) Manager.
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=[] web Sites
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+ g Default web Site

—| % Default SMTP Yirtual Server

d % Carnains

ﬂ Current Sessions

2 Ikems

Screenshot 53 - Internet Information Services (1IS) Manager

3. In the left pane, expand the respective server node. Right click on
Default SMTP Virtual Server and select Properties.

4. Select the IP address currently assigned to your SMTP server and
click OK.

5. Expand the Default SMTP Virtual Server node.

6. Right click Domains and select New » Domain.

7. Select the Remote option and click Next.

8. Specify domain name (e.g. test.gfi.com) and click Finish.

Step 3: Enable email relaying to your Microsoft Exchange server:
1. Right click on the new domain (e.g. test.gficom) and select
Properties.

2. Select the Allow the Incoming Mail to be Relayed to this
Domain checkbox.
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domain.com Properties ﬂ |

General | Advanced I

% domain. com

Select the appropriate zettingz for pour remote domair.

V¥ Allow incoming mail to be relayed ta this domain

[T Send HELD instead of EHLD

Outbound Security....

Foute domain
" Use DMS to route ta this domain

% Forward all mail to smart host

[132.168.0.2]

Cancel Apply Help

Screenshot 54 - Configure the domain

3. Select the Forward all mail to smart host option and specify the
IP address of the server managing emails in this domain. IP address
must be enclosed in square brackets e.g. [123.123.123.123] so to
exclude them from all DNS lookup attempts.

4. Click OK to finalize your configuration.

Step 4: Secure your SMTP email-relay server

If unsecured, your mail relay server can be exploited and used as an
open relay for spam. To avoid this from happening, it is recommended
that you specifically define which mail servers can route emails
through this mail relay server (i.e. allow only specific servers to use
this email relaying setup). To achieve this:

1. Go to Start » Control Panel » Administrative Tools.

2. Click on Internet Information Services (IIS) Manager.

3. In the left pane, expand the respective server node. Right click on
Default SMTP Virtual Server and select Properties.

4. Click on the Access tab and select Relay.
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Select which computer may relay through this wirtual zerver:

& Only the list below
Al except the list below

Compriters:
Arcoess | IP Address [Mask] / Domain Mame
Add... | Hemeye |

¥ Allow all computers which successfully authenticate ta relay, regardless
of the lizt above.

| F, I Cancel Help

Screenshot 55 - Relay options

5. Select the Only the list below option and click Add.

6. Specify IP(s) of the mail server(s) that are allowed to route emails
through your mail relay server. You can specify:

e Single computer — i.e. Authorize one specific machine to relay
email through this server. Use the DNS Lookup button to lookup
an |IP address for a specific host.

e Group of computers — i.e. Authorize specific computer(s) to relay
emails through this server.

e Domain - Allow all computers in a specific domain to relay emails
through this server.

NOTE: The Domain option adds a processing overhead that can
degrade SMTP service performance. This is due to the reverse
DNS lookup processes triggered on all IP addresses (within that
domain) that try to route emails through this relay server.

Step 5: Configure Lotus Domino for GFI MailEssentials

a. Configure Lotus Domino to send outbound emails through GFI
MailEssentials

1. From the ‘Lotus Domino Administrator’, click Configuration tab and
select configurations item under the server node.

2. From the ‘Configurations main window, select the server to use with
GFI MailEssentials and click edit configuration.

3. Select Router/SMTP tab and ensure Basics is selected.

4. Double click on the content to edit. Select Relay host for
messages leaving the local internet domain option and key in the
IP address of the mail gateway server where GFI MailEssentials is
installed.
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5. Click Save and Close to save configuration.
b. Configure Lotus Domino LDAP settings

1. From the ‘Directory Assistance database’, click on Add directory
assistance to create a new Assistance document.

2. Select the LDAP Clients checkbox from the ‘Make this domain
available to:’ option.

3. From the ‘server configuration’, edit the credentials under the
configuration. Enable Anonymous authentication to allow GFlI
MailEssentials to access Lotus Domino LDAP.

Step 6: Update your domain MX record to point to mail relay server

Update the MX record of your domain to point to the IP of the new
mail relay server. If your DNS server is managed by your ISP, ask
your ISP to update the MX record for you.

If MX record is not updated all emails will be routed directly to your
email server - hence by-pass GFI MailEssentials anti spam filters.

Verify that MX record has been successfully updated
To verify whether MX record is updated:

1. Click Start » Run and type Command

2. From the command prompt type in: nslookup

3. Type in: set type=mx

4. Specify your mail domain name.

The MX record should return a single IP address. This should be the
mail relay server |.P. address.

24| C WINNT' Sy stem32' cmd.exe - nslookup ==l 3 I

Microsoft Windows 2888 [Wersion 5.88.21951] I!
(C> Copyright 1985-2000 Microsoft Corp.

C:xDocuments and Settingshadministrator.GHOST >nslookup
Default Server: server—ga
Address: 192.168.8.1

> set type=mx

> gatest.com

Server: server—ga
Address: 192.168.8.1

jatest.com MY preference = 18. mail exchanger = gatest.com
gatest.com internet address = 192.168.8.1%3
>

Screenshot 56 - Checking the MX record of your domain

Step 7: Test your new mail relay server

Before proceeding to install GFI MailEssentials, verify that your new
mail relay server is working correctly by doing as follows:

Test IIS SMTP inbound connection via test email

1. Send an email from an ‘external’ account (e.g. internet email
account) to an internal email address/user.

2. Ensure that intended recipient received the test email in the
respective email client.

Test IIS SMTP outbound connection via test email

1. Send an email from an ‘internal’ email account to an external
account (e.g. internet email)
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2. Ensure that the intended recipient/external user received the test
email.

NOTE: You can also use ‘Telnet’ to manually send the test email and
obtained more troubleshooting information. For more information refer
to:

http://support.microsoft.com/support/kb/articles/Q153/1/19.asp

5.4.2 Upgrade from earlier version

If you are currently using a previous version of GFI MailEssentials
(versions 9, 10, 11 and 12), you can upgrade your current installation
while at the same time retain all your existing configuration settings.

Important notes

e Upgrades cannot be undone i.e. you cannot downgrade to an
earlier version once you have installed the latest version.

e On upgrading an existing installation, licensing reverts to trial
version and a new fully purchased license key for the GFl
MailEssentials 14 is required. For more information on new license
keys, refer to: http://customers.gfi.com.

e You cannot change the installation path during GFI MailEssentials
upgrades.

e When upgrading from GFI MailEssentials 9, the current Bayesian
weights file will be upgraded to the new format used in GFI
MailEssentials 10 or later. The new format is more compact and
uses less memory. NO DATA WILL BE LOST.

Upgrade procedure

1. Launch GFI MailEssentials installation on the server where your
earlier version of GF| MailEssentials is installed.

GFI MailEssentials <]

€ | GFIMalEssentials version 12.0.2007.1203 is already installed. ‘fou must uninstall the existing version befors installing GFI
- MailEssentials version 12.0,2008.0524,

IMPORTANT: The new build requires the Microsaft \MET Framework 2.0 installed an this machine,

Do wou wank to uninstall the existing version of GFI MailEssentials?

Screenshot 57 - Confirm the upgrade

2. Click Yes to start the upgrade process and follow on-screen
instructions. For assistance refer to New installations section below.

5.4.3 New installations

Important notes

1. During installation, GFI MailEssentials restarts IIS services. This is
required to allow GFIl MailEssentials components to be registered and
started.

2. Before starting installation, close any running Windows applications.
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Installation procedure

1. Logon the email gateway server where GFI MailEssentials will be
installed using administrator credentials.

2. Double click mailessentials14.exe (32-bit install) or
mailessentials14_x64.exe (64-bit install) accordingly.

3. Select install language and click Next.

4. Select whether to check for newer versions/builds of GFlI
MailEssentials and click Next.

5. Read licensing agreement. To proceed with the installation select |
accept the license agreement and click Next.

6. Click Next to install in default location or click Browse to change
path.

7. Specify user details and enter license key. Click Next to continue.

iix‘!rl' GFI MailEssentials Setup !IE E |

Mail Server

b ail Server Information

Specify the |P addrezs of the maching running the mail server and specify pour
lozal domain [i.e mycompary. com)

IF Address: I'I 92.168.0.34 on pork |25

Local domai: IDnminutest.Inca[

GFI MailE zzentials®

< Back I Mest » I Cancel |

Screenshot 58 — Specify mail server details

8. Specify IP address and listening port of Lotus Domino Server and
the external domain name used. Click Next to continue.

9. Specify the email address where notifications (e.g. failed anti spam
filters, spam digests) are sent.
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]‘E GFI MailEssentials Setup M= E3
>

Active Directory

Access to Active Directony uszers

[loes thiz server have access ta all the email uzers in Active Directary?

v'ez, all email uzers are available on Active Directon, wlez wil be bazed on
Active Directony users.

o Mo, | do not have Active Directory or my network. dogs naot have access to
Active Directoy [DME], iiles will be bazed on SMTP email addreszes.

GFI M ailE zzentialz®

< Back Cancel

Screenshot 59 - Selecting SMTP mode

10. Select No, | do not have Active Directory... option to use SMTP
server to get the list of email users. Click Next to continue.

fi& GFI MailEssentials Setup =]

Microzoft Meszage Queuing Service

The GFI MailE zzentials Lizt Server requires the Microzoft Message Queuing Service
[MSHML]. The Meszaging Queuing Service iz a scalable system service developed by
bdicrozoft to enable high wolume event proceszing. Thiz zervice iz included with evemn
Windows 2000, %P and 2003 versions, although not abwaps installed by default.

The GFI MailE szentials inztallation can ingtall M5O for you, To complete this process,
wou will require the wWindows 2000, =P or 2003 CO

Wwe recommend to inztall the M5O at this point howeser pou can alzo install it at a later
stage. Fleaze nate that you cannot use the List Server without BMSHG.

Do pou want o install the MSMO service now?

GFI M ailE zzential=®

< Back Mest » | Cancel

Screenshot 60 - Installing Microsoft Message Queuing Service

11. If Microsoft Message Queuing Services (MSMQ) is not installed
then the dialog in the above screenshot will open. To be able to use
list servers (i.e. distributions lists), select Yes to install MSMQ.
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i'é" GFI MailEzzentialz for ExchangefSMTP Setup !E[E

Confirm inbound email domains }1-‘ {:
i

Click Mest to begin installation.

The follawing inbound emall domains were found:

gfi.co.uk
gfi.com
gfimalta.conm
lozalhost

& GFl MailEzzentialz can only process emails addressed to the domaing
lizted above. Therefore, if SPAk email iz ent to a domain not lizted
above it will not be blocked.

To further configure the above domainz, open the GFI Mailk zzentialz
cohfiguration, nght click on the General node and select Properties

GFI MailE zzentials®

¢ Back | Mext » I Cancel

Screenshot 61 - Configure your inbound email domain

12. Setup will now display the list of inbound email domains detected.
Verify that all inbound email domains to be protected against spam
are listed. Take note of any changes required for post-installation and
click Next.

NOTE: You can modify the list of inbound email domains ONLY post-
install. For more information refer to the Confirm domains to defend
against spam section starting on page 96 below in this manual.

13. Click Finish to finalize your installation. On completion, setup will:
e Ask you to restart the SMTP service.

IMPORTANT: Failing to restart the SMTP service will
negatively affect anti spam filtering and email flow.

e Check whether Microsoft XML engine is installed. This is
automatically installed if not found on UK/US English OS. For
other OS languages, this has to be manually downloaded and
installed. Microsoft XML engine can be downloaded from:

http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e Prompt you to launch the Quick Start Guide. This is a set of
instructions that will guide you through the configuration settings
required post-install/for first use (Recommended).

14. At this stage, GFI MailEssentials is installed. You must now
configure GFI MailEssentials for first use. For instructions refer to the
Post-install actions section below.

5.4.4 Post-install actions

To ensure that your GFI MailEssentials anti spam system is effectively
up and running you must perform the following post-install actions:
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Step 1: Launch GFI MailEssentials Configuration console

Click on Start » All Programs » GFl MailEssentials » GFI
MailEssentials Configuration.

Step 2: Verify current DNS Server settings

1. Right click Anti spam node and select Properties.

2. Click on the DNS Server tab. Verify the DNS server details
automatically detected during install.

3. To specify a different DNS Server, select Use the following DNS
server and specify details.

4. Click Test to check your newly added DNS server settings.
5. Click OK to finalize your configuration.

Step 3: Confirm domains to defend against spam

NOTE: ONLY the inbound email domains configured in GFI
MailEssentials will be protected against spam.

1. Right click General node and select Properties.

2. Click on the Inbound Email Domains tab and ensure that all
required inbound domains are listed in the Inbound domains field.

3. To specify additional domains, click Add... and enter inbound email
domain details.

4. Click OK button to finalize your configuration.

Step 4: Enable Directory Harvesting

This filter uses Active directory or LDAP lookups to verify whether
inbound emails are addressed to legitimate ‘internal’ email accounts.
To enabile this filter:

1. Right click Anti spam node and select Directory Harvesting »
Properties.

2. Select Enable directory harvesting protection.
3. Select the Use LDAP lookups and:

a. Unselect the Anonymous bind option if your LDAP server
requires authentication

b. Enter the authentication details using Domain\User format.
c. Click Test button to test your LDAP configuration settings.

Step 5: Configure whitelists

This filter allows you to specify lists of ‘friendly’ email domains, email
addresses or |IP addresses.

WARNING: USE THIS FEATURE WITH CAUTION. Entries in this list
will not be scanned for spam and will bypass all anti spam filtering.

1. Right click Anti spam node and select Whitelist » Properties.
2. Click on the Whitelist tab.

3. Click Add... and specify domains/email addresses or |IP addresses
to whitelist.

96 ¢ 4BlInstallation for Lotus Domino Getting Started Guide



4. Click OK to finalize your configuration.

Step 6: Test your anti spam system

GFI MailEssentials is now ready to start managing spam. To verify
that anti spam is working properly:

1. Clicking Start » All Programs » GFl MailEssentials » GFI
MailEssentials Dashboard.

2. Using an external email account (for example webmail, hotmail or
Gmail), create a new email and key in “100% free” as the subject.

3. Send the email to one of your internal email accounts. GFI
MailEssentials will tag this email as spam by adding the tag [SPAM] to
the email ‘subject’ field.

4. Allow some time for email delivery and confirm that email spam
tagging is working by:

3 GFI MailEssentials Dashboard M=l B3
Eile  Options  Help

| Statisticsl FZE Loggingl

— Statug of key services

C:’J GFl MailE szential: Managed Attendant Service iz Running (890 GFI List Server iz Running

{‘) GFl MailE szential: Legacy Attendant Service iz Running -&- GFl MailE szential: POP2Exchange Service is Running

ﬂ GFl MailE szentials Enterprize Transfer Agent iz Running C_) 115 Admin Service is Running

MTA Logging
Processzed Time I Filker Level I Sender | Recipients | Subject AI
=4 22642009 2:00:24 PM FullEmal  “John Dog" <johndoe® hotmail coms johindoe@domain. com 100%% Free

=]

J | o

Screenshot 62 - Testing your anti spam system

e Checking the GFI MailEssentials Dashboard. Use the Status tab
to view the status of key GFI MailEssentials services and email
processing activity. Receipt and processing status of this email is
logged in the MTA logging window.
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U.5. Treasury Department, Federal Reserve, America Bankers
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Ld 6 Bed
1Item L

Screenshot 63 — Email tagged as SPAM

e Accessing the inbox of the email account to which the test email
was sent and confirm that email subject includes [SPAM] in the
subject field.

5.4.5 GFI MailEssentials Configuration

At this stage, your GFIl MailEssentials anti spam system is up and
running. All inbound email will be scanned by the anti spam filters
enabled by default (Table 13 - Anti spam filters enabled by default

below
e Enabled by
Description Default

An anti spam engine, which determines if

SpamRazer an email is spam _by_usmg email reputation, v
message fingerprinting and content
analysis.

Directo Stops email which is randomly generated

H ry towards a server, mostly addressed to non- v

arvesting :

existent users.
Blocks emails that contain links in the

PURBL message bodies p0|_nt|ng _to kn0\_/vn _phlshmg v
sites or if they contain typical phishing
keywords.

SPF Stops email which is received from x
domains not authorized in SPF records

Auto-Whitelist Addresses that an email is sent to are v

automatically excluded from being blocked.
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Whitelists A custom list of safe email addresses v

Custom A custom list of blocked email users or v
blacklist domains.

Checks if the email received is from
DNS blacklists | senders that are listed on a public DNS v
blacklist of known spammers.

Stops emails which contain links to
SURBL domains listed on public Spam URI v
Blocklists such as sc.surbl.org

A module which analyses the individual

cHr?:c?keirrw fields in a header by referencing the SMTP v
9 and MIME fields

Keyword Spam messages are identified based on x

checking blocked keywords in the email title or body

Emails that have been received from
New Senders senders to whom emails have never been X
sent before.

An anti spam technique where a statistical
probability index based on training from X
users is used to identify spam.

Bayesian
analysis

v’ - Enabled by default

X - Not enabled by default
Table 13 - Anti spam filters enabled by default

By default, email classified as spam will be tagged (i.e. will include the
prefix [SPAM] in the subject field — see Screenshot 63 above).
Although enabled by default, email tagging is NOT the only anti spam
filter action that can be triggered on detection of email spam (see
Table 14 - Anti spam filter actions below). Other actions include re-
routing of spam emails to specific folders and deletion of spam emails.

Anti spam filter actions

email address
Move to subfolder in
user mailbox
folder

Forward to specific
Move to junk mail

SN \ove to specific folder

SpamRazer v v v v v
Directory Harvesting v v 4 4 v
PURBL v v v v v
SPF v v v v v
Whitelists O O O O O

Getting Started Guide 4BInstallation for Lotus Domino e 99



Custom Blacklist
DNS blacklists
SURBL

Header Checking

ANEER N N NN

Keyword Checking

AN N N N A N N

New Senders X

SN N N N N N
DI N N N N N
AN N N N VS
AN N NN Y N

Bayesian Analysis v v

v' - Action supported
X - Action not possible

O - Not applicable
Table 14 - Anti spam filter actions

Configuration of anti spam filters and actions is possible via the GFI
MailEssentials Configuration console. Additionally, through this
console you can also run reports and customize other product
features such as enable daily spam digest.

For guidelines on how to configure GFI MailEssentials functions and
features refer to the GFI MailEssentials Administration and
Configuration manual.
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6 Installation for SMTP Servers

6.1 Introduction

Installing GFI MailEssentials with other SMTP enables you to scan all
inbound emails received from ‘outside’' (i.e. the internet) for spam
before reaching your SMTP Server. Outbound emails relayed to GFI
MailEssentials are also processed (e.g. adding of disclaimers and
auto-whitelisting) before these are sent via internet.

To install GFI MailEssentials with other SMTP servers, the server
where GFI MailEssentials is installed must be configured as an email
gateway server (also known as "Smart host" or "Mail relay" server) for
all your email. All inbound and outbound email must pass through this
server for scanning before being relayed to the mail server for
distribution.

6.2 System requirements
6.2.1 Software

Supported operating systems

e Microsoft Windows Server 2008 (x86 or x64)

e Microsoft Windows Server 2003 Standard/Enterprise (x86 or x64)
e Microsoft Windows 2000 Server/Advanced Server (SP1 or higher)
e Microsoft Small Business Server 2000 (SP2) / 2003 (SP1)

Mail Servers

e Any SMTP compliant email server

Other components

e Microsoft NET Framework 2.0

e Microsoft Data Access Components (MDAC) 2.8 - This
component is used by GFI MailEssentials’ mail archiving feature to
communicate with databases. Download this component from:

http://www.microsoft.com/Downloads/details.aspx?familyid=6C050
FE3-C795-4B7D-B037-185D0506396C&displaylang=en

e Internet Information Services (lIS) (x32 or x64) — SMTP service
and WWW service. This is required to enable communications
between GFI MailEssentials and your SMTP server.

e Microsoft XML core services: This is required by the GFI
MailEssentials reporter to enable anti spam report generation. For
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UK/US English OS this is installed automatically by GFI
MailEssentials. For other languages, this can be downloaded from:

http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e (OPTIONAL) Microsoft Message Queuing Services: This is
required ONLY if list servers are used. MSMQ is used by GFI
MailEssentials to ensure the reliable running of distributions lists
on list servers. For more information on list servers refer to ‘List
servers’ section in the Administration and Configuration manual.

6.2.2 System requirements: Hardware

Processor

e Minimum: Intel Pentium or compatible 1 GHz 32-bit processor

¢ Recommended: x64 architecture-based server with Intel 64
architecture or AMD64 platform

Memory

e Minimum: 1GB
e Recommended: 2GB RAM

Physical Storage

¢ Minimum: 500MB for installation, 2GB for execution
¢ Recommended: 500MB for installation, 4GB for execution

6.3 Important settings

6.3.1 Antivirus and backup software

Antivirus and backup software may cause GFI MailEssentials to
malfunction. This occurs when such software denies access to certain
files required by GFI MailEssentials.

Disable third party antivirus and backup software from scanning the
following folders:

x86 installations (32-bit) X64 installations (64-bit)

<..\Program Files

<.\Program Files\GFI\MailEssentials> (x86)\GFI\MailEssentials>

<..\Program Files (x86)\Common

<..\Program Files\Common Files\GFI> Files\GEI>

<.\Inetpub\mailroot> If installed on a gateway machine.
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6.3.2 Firewall port settings

Configure your firewall to allow the following port connections. These
ports are used by GFIl MailEssentials to connect to GFI servers:

e DNS (Port 53) - Used by anti spam filters (DNS blacklist, Sender
Policy Framework, Header Checking) to identify the domain from
where received emails originated.

e FTP (Ports 20 and 21) — Used by GFI MailEssentials to connect
to ‘'ftp.dfisoftware.com' and retrieve latest product version
information.

e HTTP (Port 80) — Used by GFI MailEssentials to download
product patch and anti spam filter updates (i.e. SpamRazer, Anti-
Phishing, and Bayesian anti spam filters) from the following
locations:

o 'http://update.gfi.com’

0 'http://update.gfisoftware.com’

o0 'http://support.gfi.com

o0 'http://db11.spamcatcher.net' (GFI MailEssentials 14 or
earlier)

0 'http://sn92.mailshell.net' (GFI MailEssentials 14 SR1 or
later)

e Remoting (Ports 8021) - Used in the latest builds of GFI
MailEssentials for inter-process communication. No firewall
configuration is required to allow connections to or from the
remoting ports since all the GFI MailEssentials processes run on
the same server.

NOTE: Ensure that no other applications (except GFlI
MailEssentials) are listening on port 8021.

e (LDAP (Port 389) — Used by GFI MailEssentials to get email
addresses from SMTP server.

6.4 Installing on gateway servers for SMTP Servers

6.4.1 Pre-install actions

GFI MailEssentials uses the IS SMTP service as its SMTP Server
and therefore the [IS SMTP service must be configured to act as a
mail relay server. This is achieved as follows:

Step 1: Enable IIS SMTP Service

1. Go to Start » Control Panel » Add or Remove Programs »
Add/Remove Windows Components.

2. Select Internet Information Services (lIS) and click Details.

3. Select the SMTP Service option and click OK.

4. Click Next to finalize your configuration.

Step 2: Create SMTP domain(s) for email relaying

1. Go to Start » Control Panel » Administrative Tools.
2. Click on Internet Information Services (lIS) Manager.
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2 Ikems

Screenshot 64 - Internet Information Services (1IS) Manager

3. In the left pane, expand the respective server node. Right click on
Default SMTP Virtual Server and select Properties.

4. Select the IP address currently assigned to your SMTP server and
click OK.

5. Expand the Default SMTP Virtual Server node

6. Right click Domains and select New » Domain.

7. Select the Remote option and click Next.

8. Specify domain name (e.g. test.gfi.com) and click Finish.

Step 3: Enable email relaying to your Microsoft Exchange server:
1. Right click on the new domain (e.g. test.gficom) and select
Properties.

2. Select the Allow the Incoming Mail to be Relayed to this
Domain checkbox.
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domain.com Properties ﬂ |

General | Advanced I

% domain. com

Select the appropriate zettingz for pour remote domair.

V¥ Allow incoming mail to be relayed ta this domain

[T Send HELD instead of EHLD

Outbound Security....

Foute domain
" Use DMS to route ta this domain

% Forward all mail to smart host

[132.168.0.2]

Cancel Apply Help

Screenshot 65 - Configure the domain

3. Select the Forward all mail to smart host option and specify the
IP address of the server managing emails in this domain. IP address
must be enclosed in square brackets e.g. [123.123.123.123] so to
exclude them from all DNS lookup attempts.

4. Click OK to finalize your configuration.

Step 4: Secure your SMTP email-relay server

If unsecured, your mail relay server can be exploited and used as an
open relay for spam. To avoid this from happening, it is recommended
that you specifically define which mail servers can route emails
through this mail relay server (i.e. allow only specific servers to use
this email relaying setup). To achieve this:

1. Go to Start » Control Panel » Administrative Tools.

2. Click on Internet Information Services (IIS) Manager.

3. In the left pane, expand the respective server node. Right click on
Default SMTP Virtual Server and select Properties.

4. Click on the Access tab and select Relay.
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Select which computer may relay through this wirtual zerver:
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Add... | Hemeye |

¥ Allow all computers which successfully authenticate ta relay, regardless
of the lizt above.

| F, I Cancel Help

Screenshot 66 - Relay options

5. Select the Only the list below option and click Add.

6. Specify IP(s) of the mail server(s) that are allowed to route emails
through your mail relay server. You can specify:

e Single computer — i.e. Authorize one specific machine to relay
email through this server. Use the DNS Lookup button to lookup
an |IP address for a specific host.

e Group of computers — i.e. Authorize specific computer(s) to relay
emails through this server.

e Domain - Allow all computers in a specific domain to relay emails
through this server.

NOTE: The Domain option adds a processing overhead that can
degrade SMTP service performance. This is due to the reverse
DNS lookup processes triggered on all IP addresses (within that
domain) that try to route emails through this relay server.

Step 5: Configure your SMTP server for GFl MailEssentials

Refer to the SMTP server documentation on forwarding email to the
GFI MailEssentials server.

Step 6: Update your domain MX record to point to mail relay server.

Update the MX record of your domain to point to the IP of the new
mail relay server. If your DNS server is managed by your ISP, ask
your ISP to update the MX record for you.

If the MX record is not updated, all emails will be routed directly to
your email server - hence by-pass GFI MailEssentials anti spam
filters.

Verify that MX record has been successfully updated
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To verify whether MX record is updated do as follows:
1. Click Start » Run and type in Command

2. From the command prompt type in: nslookup

3. Type in: set type=mx

4. Specify your mail domain name.

The MX record should return a single IP address. This should be the
mail relay server I.P. address.

WINNT" System32'.cmd.exe - nslookup [_ 00! l

Microsoft Windows 2WHA [Version 5.80A.21951] l’
{C> Gopyright 1985-28808 Microsoft GCorp.

C:sDocuments and Settingshadministrator.GHOST >nslookup
Default Server: server—ga
Address: 192.168.8.1

> set type=mx
> gatest.com
Server: sServer—

a
Address: 192.168.8.1

gatest.com MX preference = 18. mail exchanger = gatest.com
gatest.com internet address = 192.168.8.153
>

Screenshot 67 - Checking the MX record of your domain

Step 7: Test your new mail relay server

Before proceeding to install GFI MailEssentials, verify that your new
mail relay server is working correctly by doing as follows:

Test IIS SMTP inbound connection via test email

1. Send an email from an ‘external’ account (e.g. internet email
account) to an internal email address/user.

2. Ensure that intended recipient received the test email in the
respective email client.

Test IIS SMTP outbound connection via test email

1. Send an email from an ‘internal’ email account to an external
account (e.g. internet email).

2. Ensure that the intended recipient/external user received the test
email.

NOTE: You can also use ‘Telnet’ to manually send the test email and
obtained more troubleshooting information. For more information refer
to:

http://support.microsoft.com/support/kb/articles/Q153/1/19.asp

6.4.2 Upgrade from earlier version

If you are currently using a previous version of GFI MailEssentials
(versions 9, 10, 11 and 12), you can upgrade your current installation
while at the same time retain all your existing configuration settings.

Important notes

¢ Upgrades cannot be undone i.e. you cannot downgrade to an
earlier version once you have installed the latest version.

e On upgrading an existing installation, licensing reverts to frial
version and a new fully purchased license key for the GFI
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MailEssentials 14 is required. For more information on new license
keys, refer to: http://customers.gfi.com

e You cannot change the installation path during GFI MailEssentials
upgrades.

e When upgrading from GFI MailEssentials 9, the current Bayesian
weights file will be upgraded to the new format used in GFI
MailEssentials 10 or later. The new format is more compact and
uses less memory. NO DATA WILL BE LOST.

Upgrade procedure

1. Launch GFI MailEssentials installation on the server where your
earlier version of GFI MailEssentials is installed.

GFI MailEssentials <]

€ | GFIMalEssentials version 12.0.2007.1203 is already installed. ‘fou must uninstall the existing version befors installing GFI
__-/ MailEssentials version 12.0,2008.0524,

IMPORTANT: The new build requires the Microsaft \MET Framework 2.0 installed an this machine,

Do wou wank to uninstall the existing version of GFI MailEssentials?

Screenshot 68 - Confirm the upgrade

2. Click Yes to start the upgrade process and follow on-screen
instructions. For assistance refer to New installations section below.

6.4.3 New installations

Important notes

1. During installation, GFI MailEssentials restarts IIS services. This is
required to allow GFIl MailEssentials components to be registered and
started.

2. Before starting installation, close any running Windows applications.

Installation procedure

1. Logon your Microsoft Exchange Server machine using administrator
credentials.

2. Double click mailessentials14.exe (32-bit install) or
mailessentials14_x64.exe (64-bit install) accordingly.

3. Select install language and click Next.

4. Select whether to check for newer versions/builds of GFI
MailEssentials and click Next.

5. Read licensing agreement. To proceed with the installation select |
accept the license agreement and click Next.

6. Click Next to install in default location or click Browse to change
path.

7. Specify user details and enter license key. Click Next to continue.
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iig!;'- GFI MailEssentials Setup M=l E3 |

Mail Server

M ail Server Information

Specify the |P addrezs of the machine running the mail server and specify pour
lozal domain [i.e mycampaty. com)

IF Address: |1 92 168.0.34 an port |25

Local domain: IDnminutest.IDc:al

GFI M ailE zzentials®

< Back I Memt » I Cancel |

Screenshot 69 — Specify mail server details

8. Specify IP address and listening port of your SMTP server and the
external domain name used. Click Next to continue.

9. Specify the email address where notifications (e.g. failed anti spam
filters, spam digests) are sent.

ii-.'!rl' GFI MailEssentials Setup M= E |

Active Directory

Access to Active Directony users

Does this zerver have access to all the email uzers in Active Directony?

‘r'ez, all email uzers are available on Active Directon, wlez wil be baszed on
Active Directon users.

o Mo, | do not have Active Directory or my network. does not have acoess to
Active Directary [DE], miles will be based on SMTP email addrezses.

GFI MailE zzentials®

Cancel |

Screenshot 70 - Selecting SMTP mode

10. Select No, | do not have Active Directory... option to use SMTP
server to get the list of email users. Click Next to continue.
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]‘E GFl MailE szentials Setup [ [

Microzoft Meszage Queuing Service

The GFl MailE zzentials Lizt Server requires the Microzoft Meszage Queuing Service
[MSkE]. The Meszaging Queuing Service iz & scalable system service developed by
ticrozoft to enable high wolume event proceszing. Thiz service i included with eveny
Windows 2000, %P and 2003 verzionz, although not abways inztalled by default

The GFI MailE zzentialz installation can install MSMO for you, To complete thiz process,
wou will reguire the windows 2000, =P ar 2003 CD .

We recommend to inztall the MSMO at this point howeser pou can also install it at a later
stage. Fleaze note that you cannot uze the List Server without kS kGL

Do pou want toingtall the MSMO eervice now?

GFI MailE zzentials®

¢ Back Mewt = | Cancel

Screenshot 71 - Installing Microsoft Message Queuing Service

11. If Microsoft Message Queuing Services (MSMQ) is not installed
then the dialog in the above screenshot will open. To be able to use
list servers (i.e. distributions lists), select Yes to install MSMQ.

]'E GFI MaillEzsentials for Exchange/SMTP Setup M= E3

Confirm inbound email domains

Click Mext to begin inztallation.

The following inbound email domains were found:

gfi.co.uk
qgfi.cam
gfimalta.com
lozalhost

& GF| MailEzzentialz can only proceszs email: addrezzed to the domaing
listed abowve. Therefare, i SPAM email iz zent to a domain not listed
above it will not be blocked.

To further configure the above domainz, open the GFl Mailk szentialz
configuration, right click on the General node and select Properties

GFI b ailE zzential=®

< Back Mext » | Cancel

Screenshot 72 - Configure your inbound email domain

12. Setup will now display the list of inbound email domains detected.
Verify that all inbound email domains to be protected against spam
are listed. Take note of any changes required for post-installation and
click Next.
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NOTE: You can modify the list of inbound email domains ONLY post-
install. For more information refer to the Confirm domains to defend
against spam section starting on page 111 in this manual.

13. Click Finish to finalize your installation. On completion, setup will:
e Ask you to restart the SMTP service.

IMPORTANT: Failing to restart the SMTP service will
negatively affect anti spam filtering and email flow.

e Check whether Microsoft XML engine is installed. This is
automatically installed if not found on UK/US English OS. For
other OS languages, this has to be manually downloaded and
installed. Microsoft XML engine can be downloaded from:

http://www.microsoft.com/downloads/details.aspx?Familyld=3144
B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en

e Prompt you to launch the Quick Start Guide. This is a set of
instructions that will guide you through the configuration settings
required post-install/for first use (Recommended).

14. At this stage, GFI MailEssentials is installed. You must now
configure GFIl MailEssentials for first use. For instructions refer to the
Post-install actions section below.

6.4.4 Post-install actions

To ensure that your GFl MailEssentials anti spam system is effectively
up and running you must perform the following post-install actions:

Step 1: Launch GFI MailEssentials Configuration console

Click on Start » All Programs » GFl MailEssentials » GFI
MailEssentials Configuration.

Step 2: Verify current DNS Server settings

1. Right click Anti spam node and select Properties.

2. Click on the DNS Server tab. Verify the DNS server details
automatically detected during install.

3. To specify a different DNS Server, select Use the following DNS
server and specify details.

4. Click Test to check your newly added DNS server settings.
5. Click OK to finalize your configuration.

Step 3: Confirm domains to defend against spam

NOTE: ONLY the inbound email domains configured in GFI
MailEssentials will be protected against spam.

1. Right click General node and select Properties.

2. Click on the Inbound Email Domains tab and ensure that all
required inbound domains are listed in the Inbound domains field.

3. To specify additional domains, click Add... and enter inbound email
domain details.

4. Click OK button to finalize your configuration.

Getting Started Guide 5BInstallation for SMTP Servers ¢ 111


http://www.microsoft.com/downloads/details.aspx?FamilyId=3144B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyId=3144B72B-B4F2-46DA-B4B6-C5D7485F2B42&displaylang=en�

Step 4: Enable Directory Harvesting

This filter uses Active directory or LDAP lookups to verify whether
inbound emails are addressed to legitimate ‘internal’ email accounts.
To enabile this filter:

1. Right click Anti spam node and select Directory Harvesting »
Properties.

2. Select Enable directory harvesting protection.
3. Select the Use LDAP lookups and:

a. Unselect the Anonymous bind option if your LDAP server
requires authentication

b. Enter the authentication details using Domain\User format.
c. Click Test button to test your LDAP configuration settings.

Step 5: Configure whitelists

This filter allows you to specify lists of ‘friendly’ email domains, email
addresses or |IP addresses.

WARNING: USE THIS FEATURE WITH CAUTION. Entries in this list
will not be scanned for spam and will bypass all anti spam filtering.

1. Right click Anti spam node and select Whitelist » Properties.
2. Click on the Whitelist tab.

3. Click Add... and specify domains/email addresses or IP addresses
to whitelist.

4. Click OK to finalize your configuration.
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Step 6: Test your anti spam system

GFI MailEssentials is now ready to start managing spam. To verify
that anti spam is working properly:

1. Clicking Start » All Programs » GFl MailEssentials » GFI
MailEssentials Dashboard.

2. Using an external email account (for example webmail, hotmail or
Gmail), create a new email and key in “100% free” as the subject.

3. Send the email to one of your internal email accounts. GFI
MailEssentials will tag this email as spam by adding the tag [SPAM] to
the email ‘subject’ field.

4. Allow some time for email delivery and confirm that email spam
tagging is working by:

3 GFI MailEssentials Dashboard M=l B3

Eile  Options  Help

| Statisticsl FZE Loggingl

— Statug of key services

C:’J GFl MailE szential: Managed Attendant Service iz Running (890 GFI List Server iz Running

{‘) GFl MailE szential: Legacy Attendant Service iz Running -&- GFl MailE szential: POP2Exchange Service is Running
ﬂ GFl MailE szentials Enterprize Transfer Agent iz Running C_) 115 Admin Service is Running

MTA Logging
Processzed Time I Filker Level I Sender | Recipients | Subject AI
=4 22642009 2:00:24 PM FullEmal  “John Dog" <johndoe® hotmail coms johindoe@domain. com 100%% Free

=]

J | o

Screenshot 73 - Testing your anti spam system

e Checking the GFI MailEssentials Dashboard. Use the Status tab
to view the status of key GFI MailEssentials services and email
processing activity. Receipt and processing status of this email is
logged in the MTA logging window.
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Screenshot 74 — Email tagged as SPAM

e Accessing the inbox of the email account to which the test email
was sent and confirm that email subject includes [SPAM] in the
subject field.

6.4.5 GFI MailEssentials Configuration

At this stage, your GFIl MailEssentials anti spam system is up and
running. All inbound email will be scanned by the anti spam filters
enabled by default. (See Table 15 - Anti spam filters enabled by
default below)

Enabled by

Filter Description Default

An anti spam engine that determines if an

SpamRazer email is spam by using email reputation, v
message fingerprinting and content
analysis.

Directo Stops email which is randomly generated

ry towards a server, mostly addressed to non- v

Harvesting .
existent users.
Blocks emails that contain links in the

PURBL message bodies p0|_nt|ng _to kn0\_/vn _phlshmg v
sites or if they contain typical phishing
keywords.

SPF Stops email which is received from x
domains not authorized in SPF records

Auto-Whitelist Addresses that an email is sent to are v

automatically excluded from being blocked.
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Whitelists A custom list of safe email addresses v

Custom A custom list of blocked email users or v
blacklist domains.

Checks if the email received is from
DNS blacklists | senders that are listed on a public DNS v
blacklist of known spammers.

Stops emails which contain links to
SURBL domains listed on public Spam URI v
Blocklists such as sc.surbl.org

A module which analyses the individual

cHr?:c?keirrw fields in a header by referencing the SMTP v
9 and MIME fields

Keyword Spam messages are identified based on x

checking blocked keywords in the email title or body

Emails that have been received from
New Senders senders to whom emails have never been X
sent before.

An anti spam technique where a statistical
probability index based on training from X
users is used to identify spam.

Bayesian
analysis

v’ - Enabled by default

X - Not enabled by default
Table 15 - Anti spam filters enabled by default

By default, email classified as spam will be tagged (i.e. will include the
prefix [SPAM] in the subject field - see Screenshot 74 above).
Although enabled by default, email tagging is NOT the only anti spam
filter action that can be triggered on detection of email spam (Table 16
- Anti spam filter actions below). Other actions include re-routing of
spam emails to specific folders and deletion of spam emails.

Anti spam filter actions

email address
Move to subfolder in
user mailbox
folder

Forward to specific
Move to junk mail

SN \ove to specific folder

SpamRazer v v v v v
Directory Harvesting v v 4 4 v
PURBL v v v v v
SPF v v v v v
Whitelists O O O O O
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Custom Blacklist
DNS blacklists
SURBL

Header Checking

ANEER N N NN

Keyword Checking

AN N N N A N N

New Senders X

SN N N N N N
DI N N N N N
AN N N N VS
AN N NN Y N

Bayesian Analysis v v

v' - Action supported
X - Action not possible

O - Not applicable
Table 16 - Anti spam filter actions

Configuration of anti spam filters and actions is possible via the GFI
MailEssentials Configuration console. Additionally, through this
console you can also run reports and customize other product
features such as enable daily spam digest.

For guidelines on how to configure GFI MailEssentials functions and
features refer to the GFI MailEssentials Administration and
Configuration manual.
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7 Uninstalling GFI MailEssentials

7.1 Introduction

This chapter describes how to uninstall GFlI MailEssentials for all
supported operating systems.

NOTE 1: If you are planning to uninstall and reinstall  GFl
MailEssentials to fix problems you may be having during installation,
you should first read the Troubleshooting and Support chapter in this
manual.

NOTE 2: Third-party components which are required by GFI
MailEssentials, such as Microsoft .NET Framework or Microsoft XML
core services, will not be uninstalled.

7.1.1 Uninstall GFl MailEssentials
1. Exit GFI MailEssentials.
2. From the Control Panel select:

Add or Remove Programs — Windows Server 2000 or 2003,
Windows SBS 2000 or 2003.

Programs and Features — Windows Server 2008, Windows SBS
2008.

3. From the list of installed software select GFI MailEssentials for
Exchange/SMTP and click Remove or Uninstall.

4. Follow on-screen instructions to uninstall GFI MailEssentials.
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8 Troubleshooting and support

8.1 Introduction

This chapter explains how to resolve any GFl MailEssentials issues
encountered during installation. The main sources of information
available to solve these issues are:

e This manual — most issues can be solved through the information
in this manual section.

e GFI Knowledge Base articles
e Web forums
e Contacting GFI Technical Support

8.2 Troubleshooting: Installation issues

Issue Possible solution

License key for the previous version is not
accepted and the upgraded version is in
evaluation mode.

When upgrading to a new version of GFI
MailEssentials, you are required to upgrade
your license key. For more information on
how to upgrade your key, refer to:

http://kbase.gfi.com/showarticle.asp?id=KB
ID003408

During installation some errors may be
received causing the product not to be
installed properly, or not to be installed at
all.

e Event Type: ‘Warning’
e EventID:'0’

e Event Source: ‘GFI MailEssentials
Legacy Attendant Service’

e Event Description: ‘The GFI
MailEssentials  Legacy  Attendant
Service sub-process '8-auantiphish2'
has terminated with error code [-1].The
sub-process will not be available until
the service is restarted. Please contact
GFI Support if the problem persists.’

The Microsoft Event log warnings are
created due to a missing requirement for
the GFl MailEssentials Legacy Attendant
service.

This requirement is configured by the post-
installation wizard and therefore, no
warnings of the same type will be reported
in the Microsoft event logs after completing
the GFl MailEssentials post-installation
wizard.

During installation some errors may be
received causing the product not to be
installed properly, or not to be installed at
all.

e “Error 1720.There is a problem with
this Windows Installer package.

e A script required for this install to
complete could not be run. Contact
your support personnel or package
vendor.”:

e “Setup failed to launch installation

1. Disable any real-time scanning software
such as antivirus software.

2. Ensure that you do not have any
software that automatically removes files
from the TEMP folder.

3. Log
privileges.

in with Domain Administrator

4. Download and install the latest version of

Windows Scripting Host & Windows
Installer for your Windows Operating
System from:
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engine: Access is denied.” or:

e ‘“Error installing Ikernel.exe, access is
denied.”

http://www.microsoft.com/downloads/

5. Ensure that the following Microsoft
Windows technologies are installed
correctly and not corrupt:

e Microsoft Windows Management
Instrumentation (WMI)

e  Microsoft Windows Installer
e  Microsoft .Net Framework

e Microsoft Data Access Components
(MDAC)

6. Ensure that the following system libraries
located at <Windows\System32> are
correctly registered:

e urlmon.dll

e Oleaut32.dll
e o0le32.dll

e Actxprxy.dll

e  Shell32.dll
e  Shdocvw.dll
e  Mshtml.dll

e  Browseui.dll

e Scrrun.dll

To register system libraries perform the
following steps:

a. Click Start and select Run
b. Key in: cmd.exe
c. Key in: regsvr32 <path & filename of dll>

Example: regsvr32
c:\windows\system32\urimon.dll

7. Place the installation file in a
temporary directory on the server where
you are installing the GFI product and retry
installing GFI MailEssentials.

8. Check Distributed Component
Object Model (DCOM) permissions as
explained in:
http://support.microsoft.com/default.aspx?s
cid=kb;en-us;295278

NOTE: For more information on how to
resolve common  Windows Installer
problems refer to:

http://support.microsoft.com/default.aspx?s
cid=kb;en-us;555175
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8.3 Troubleshooting: Spam management issues

After installing GFI MailEssentials,
some emails show a garbled
message body when viewed in

Microsoft  Outlook or
MailArchiver

Dashboard shows no email

being processed; Or:

Only inbound or outbound emails

are being processed

This problem occurs for emails that use one character set for the
message header and a different character set for the message
body. When such emails are processed by Microsoft Exchange
2003, the emails will be show garbled in Microsoft Outlook and GFI
MailArchiver. Microsoft has released a hotfix to resolve this issue.
More information on the problem and the hotfix can be found at:

http://kbase.gfi.com/showarticle.asp?id=KBID003459 and
http://support.microsoft.com/kb/916299

1. Ensure that GFI MailEssentials is not disabled from scanning
emails. Refer to Disabling/Enabling email scanning section in the
configuration manual for more information on how to start
scanning.

2. Check for multiple Microsoft [IS SMTP virtual servers and ensure
the GFI MailEssentials is bound to the correct virtual server.

3. MX record for domain not configured correctly. Ensure that the
MX record points to the IP address of the server running GFI
MailEssentials

4. If inbound emails are passing through another gateway, ensure
that that the mail server running on the other gateway forwards
inbound emails through GFI MailEssentials

5. Ensure that outbound emails are configured to route through GFI
MailEssentials. Refer to installation manual for more details.

6. Verify that the SMTP virtual server used by Microsoft Exchange
Server for outbound emails is the same SMTP server GFI
MailEssentials is bound to.

For more information on this issue refer to:
http://kbase.gfi.com/showarticle.asp?id=KBID003286
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8.4 Troubleshooting: Anti spam filters & actions

1. SPAM is delivered to users Follow the checklist below to solve this issue:

mailbox 1. Ensure that GFI MailEssentials is not disabled from scanning

emails. Refer to Disabling/Enabling email scanning section in the
configuration manual for more information on how to start
scanning.

2. Check if all required anti spam filters are enabled
3. Check if local domains are configured correctly

4. Check if emails are passing through GFI MailEssentials or if GFI
MailEssentials is bound to the correct IIS SMTP Virtual Server

5. Check if "%WTEMP%' location (which by default is the
‘C:\Windows\Temp’ folder) contains a lot of files

6. Check if the number of users using GFI MailEssentials exceeds
the number of purchased licenses

7. Check if whitelist is configured correctly
8. Check if actions are configured correctly
9. Check if Bayesian filter is configured correctly

Refer to http://kbase.gfi.com/showarticle.asp?id=KBID003256 for
more detailed instructions on how to solve this issue.

8.5 Knowledge Base

GFI maintains a comprehensive Knowledge Base repository, which
includes answers to the most common installation problems. In case
that the information in this manual does not solve your installation
problems, next refer to the Knowledge Base. The Knowledge Base
always has the most up-to-date listing of technical support questions
and patches. Access the Knowledge Base by visiting:

http://kbase.gfi.com/

8.6 Web Forum

User to user technical support is available via the GFI web forum.
Access the web forum by visiting:

http://forums.gfi.com/.

8.7 Request technical support

If none of the resources listed above enable you to solve your issues,
contact the GFI Technical Support team by filling in an online support
request form or by phone.

e Online: Fill out the support request form and follow the
instructions on this page closely to submit your support request on:

http://support.gfi.com/supportrequestform.asp

¢« Phone: To obtain the correct technical support phone number for
your region please visit:

http://www.dfi.com/company/contact.htm

NOTE: Before you contact our Technical Support team, please have
your Customer ID available. Your Customer ID is the online account
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number that is assigned to you when you first register your license
keys in our Customer Area at:

http://customers.gfi.com.

We will answer your query within 24 hours or less, depending on your
time zone.

8.8 Build notifications

We strongly suggest that you subscribe to our build notifications list.
This way, you will be immediately notified about new product builds.
To subscribe to our build notifications, visit:

http://www.dfi.com/pages/productmailing.htm.

8.9 Documentation

If this manual does not satisfy your expectations, or if you think that
this documentation can be improved in any way, let us know via email

on:
documentation@gfi.com
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9 Glossary

Active Directory

AD

Auto-reply

Bayesian Filtering

Background
Intelligent Transfer
Service

BITS

Blacklist

Botnet

Demilitarized Zone

Disclaimer

Domain Name
System

DMZ
DNS
DNS MX

Email monitoring
rules

False positives
Ham

s

Internet Information
Services

A technology that provides a variety of network
services, including LDAP-like directory services.

See Active Directory

An email reply that is sent automatically to incoming
emails.

An anti spam technique where a statistical
probability index based on training from users is
used to identify spam.

A component of Microsoft Windows operating
systems that facilitates transfer of files between
systems using idle network bandwidth.

See Background Intelligent Transfer Service

A list of email users or domains from whom email is
not to be received by users

Malicious software that runs autonomously and
automatically and is controlled by a hacker/cracker.

A section of a network that is not part of the internal
network and is not directly part of the Internet. Its
purpose typically is to act as a gateway between
internal networks and the internet.

A statement intended to identify or limit the range of
rights and obligations for email recipients

A database used by TCP/IP networks that enables
the translation of hosthames into IP numbers and to
provide other domain related information.

See Demilitarized Zone
See Domain Name System
See Mail Exchange

Rules which enable the replication of emails
between email addresses.

An incorrect result that identifies an email as spam
when in fact it is not.

Legitimate e-mail
See Internet Information Services

A set of Internet-based services created by Microsoft
Corporation for internet servers.
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IMAP

Internet Message
Access Protocol

LDAP

Lightweight Directory
Access Protocol

List servers

Mail Exchange

MAPI

MDAC
Messaging
Application
Programming

Interface

Microsoft Message
Queuing Services

Microsoft Data
Access Components

MIME
MSMQ

Multipurpose Internet
Mail Extensions

NDR

Non Delivery Report

Perimeter
server/gateway

phishing

POP2Exchange

POP3

See Internet Message Access Protocol

One of the two most commonly used Internet
standard protocols for e-mail retrieval, the other
being POP3.

See Lightweight Directory Access Protocol

An application protocol used to query and modify
directory services running over TCP/IP

A special use of e-mail systems that allows for
widespread distribution of emails to multiple email
users through discussion lists or newsletters.

A record used by DNS to provide the names of other
entities to which the mail should be sent.

See Messaging Application Programming Interface
See Microsoft Data Access Components

A messaging architecture and a Component Object
Model based API for Microsoft Windows.

A message queue implementation for Windows
Server operating systems.

A Microsoft technology that gives developers a
homogeneous and consistent way of developing
software that can access almost any data store.

See Multipurpose Internet Mail Extensions
See Microsoft Message Queuing Services

A standard that extends the format of e-mail to
support text other than ASCII, non-text attachments,
message bodies with multiple parts and header
information in non-ASCII character sets.

See Non Delivery Report

An automated electronic mail message the sender
on an email delivery problem.

The computer (server) in a LAN that is directly
connected to an external network. In GFl
MailEssentials perimeter gateway refers to the email
servers within the company that first receive email
from external domains.

The process of acquiring sensitive personal
information with the aim of defrauding individuals,
typically through the use of fake communications

A system that collects email messages from POP3
mailboxes and routes them to mail server.

See Post Office Protocol ver.3
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Post Office Protocol
ver.3

Public folder

RBL

Realtime Blocklist

Remote commands

Secure Sockets
Layer

Simple Mail
Transport Protocol

SMTP

Spam actions

SSL

WebDAV

Whitelist

Zombie

A protocol used by local email clients to retrieve
emails from mailboxes over a TCP/IP connection.

A common folder shared between Microsoft
Exchange users which enables information.

See Realtime Blocklist

Online databases of spam IP addresses. Incoming
emails are compared to these lists to determine if
they are originating from blacklisted users.

Instructions that facilitate the possibility of executing
tasks remotely.

A protocol to ensure an integral and secure
communication between networks.

An internet standard used for email transmission
across IP networks.

See Simple Mail Transport Protocol

Actions taken on spam emails received, e.g. delete
email or send to Junk email folder.

See Secure Sockets Layer

A HTTP extensions database that enables users to
manage files remotely and interactively. Used for
managing emails in the mailbox and in the public
folder in Microsoft Exchange.

A list of email addresses and domains from which
emails are always received

See Botnet
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Inbound mail filtering, 7

K

Keyword checking, 19, 34, 47, 59,
72,83, 100, 116

L
Licensing, 6
list server., 8

List servers, 124

M

MAPI, 124

Microsoft Exchange 2007, 73, 74
Microsoft IIS, 21, 87, 103
MSMQ, 124

(o)

Outbound mail filtering, 8

P
perimeter server, 19, 72
POP3, 124

PURBL, 19, 34, 46, 59, 72, 82,
99, 115

R

Remote commands, 125

Reports, 15, 30, 43, 55, 68, 78,
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S

SPF, 19, 34, 46, 59, 72, 82, 99,
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U

upgrade, 119
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